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Getting Started with the
cDAQ Chassis

This chapter provides a cDAQ chassis overview and lists information about mounting the
chassis and installing C Series modules.
The National Instruments four-slot CompactDAQ cDAQ-9185 and eight-slot CompactDAQ
cDAQ-9189 Ethernet chassis are designed for use with C Series modules. The cDAQ chassis are
capable of measuring a broad range of analog and digital I/O signals and sensors. For module
specifications, refer to the datasheet for your C Series module(s) on ni.com/manuals.
Figure 1-1 shows the cDAQ-9185 chassis.
Figure 1-1. NI cDAQ-9185 Chassis
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Figure 1-2 shows the cDAQ-9189 chassis.
Figure 1-2. NI cDAQ-9189 Chassis
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Safety Guidelines
Do not operate the NI cDAQ-9185/9189 in a manner not specified in this
user manual. Product misuse can result in a hazard. You can compromise the safety
protection built into the product if the product is damaged in any way. If the product
is damaged, return it to National Instruments for repair.
Caution

Note Because some C Series modules may have more stringent certification
standards than the NI cDAQ-9185/9189 chassis, the combined system may be
limited by individual component restrictions. Refer to the specifications document
for your cDAQ chassis for more details.

This icon denotes that the component may be hot. Touching this
component may result in bodily injury.
Hot Surface

Electromagnetic Compatibility Guidelines
This product was tested and complies with the regulatory requirements and limits for
electromagnetic compatibility (EMC) stated in the product specifications. These requirements
and limits provide reasonable protection against harmful interference when the product is
operated in the intended operational electromagnetic environment.
This product is intended for use in industrial locations. However, harmful interference may
occur in some installations, when the product is connected to a peripheral device or test object,
1-2
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or if the product is used in residential or commercial areas. To minimize interference with radio
and television reception and prevent unacceptable performance degradation, install and use this
product in strict accordance with the instructions in the product documentation.
Furthermore, any modifications to the product not expressly approved by National Instruments
could void your authority to operate it under your local regulatory rules.
Notice To ensure the specified EMC performance, product installation requires
either special considerations or user-installed add-on devices.

To ensure the specified EMC performance, operate this product only with
shielded cables and accessories. Note that the input DC power cables may be
unshielded.

Notice

Notice To ensure the specified EMC performance, do not connect the power
connector to a DC MAINS supply or to any supply requiring a connecting cable
longer than 3 m (10 ft). A DC MAINS supply is a local DC electricity supply network
in the infrastructure of a site or building.
Notice To ensure the specified EMC performance, the length of any I/O cable
connected to the PFI port must be no longer than 3 m (10 ft).

Special Conditions for Marine Applications
Some models are approved for marine (shipboard) applications. To verify marine approval
certification for a model, visit ni.com/product-certifications, search by model
number, and click the appropriate link.
In order to meet the EMC requirements for marine applications, install the
product in a shielded enclosure with shielded and/or filtered power and input/output
ports. In addition, take precautions when designing, selecting, and installing
measurement probes and cables to ensure that the desired EMC performance is
attained.

Notice

Unpacking
The cDAQ chassis ships in an antistatic package to prevent electrostatic discharge (ESD).
ESD can damage several components on the device.
Notice

Never touch the exposed pins of connectors.

© National Instruments
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To avoid ESD damage in handling the chassis, take the following precautions:
•

Ground yourself with a grounding strap or by touching a grounded object.

•

Touch the antistatic package to a metal part of your computer chassis before removing the
chassis from the package.

Remove the chassis from the package and inspect it for loose components or any other signs of
damage. Notify NI if the device appears damaged in any way. Do not install a damaged chassis.
Store the chassis in the antistatic package when the chassis is not in use.

Hardware Symbol Definitions
The following symbols are marked on your cDAQ chassis.
Caution When this symbol is marked on a product, refer to the Safety Guidelines
section for information about precautions to take.

When this symbol is marked on a product, the product could be damaged if
subjected to Electrostatic Discharge (ESD) on the connector pins of any I/O port.
To prevent damage, industry-standard ESD prevention measures must be employed
during installation, maintenance, and operation.

ESD

At the end of the product life cycle, all products must be sent to
a WEEE recycling center. For more information about WEEE recycling centers,
National Instruments WEEE initiatives, and compliance with WEEE Directive
2002/96/EC on Waste and Electronic Equipment, visit ni.com/environment/
weee.
EU Customers

⬉ᄤֵᙃѻક∵ᶧࠊㅵ⧚ࡲ⊩ ˄Ё

˅

Ёᅶ᠋ National Instruments ヺড়Ё⬉ᄤֵᙃѻકЁ䰤ࠊՓ⫼ᶤѯ᳝ᆇ⠽䋼ᣛҸ
(RoHS)Ǆ݇Ѣ National Instruments Ё RoHS ড়㾘ᗻֵᙃˈ䇋ⱏᔩ ni.com/
environment/rohs_chinaǄ (For information about China RoHS compliance,

go to ni.com/environment/rohs_china.)

System Health Monitoring and User Watchdog
NI recommends the use of system health monitoring and a user watchdog to ensure potential
problems are detected and resolved as soon as possible. The cDAQ-9185/9189 has hardware and
software features your application can use to monitor system health and respond to events such
as hardware faults, software failure, system crash, or any loss of communication. In addition, a
user-programmable watchdog can be enabled to either notify your application, reset your
application, or reset the chassis in the event an error occurs. For more information on how to
configure your system to monitor system health and enable a user watchdog, visit ni.com/
info and enter systemhealth.
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Kit Contents
Items in your cDAQ chassis kit:
•

cDAQ-9185 or cDAQ-9189

•

cDAQ-9185/9189 Quick Start

•

cDAQ-9185 Safety, Environmental, and Regulatory Information or cDAQ-9189 Safety,
Environmental, and Regulatory Information

•

Power connector

•

Power supply

•

NI-DAQmx driver software

What You Need to Get Started
You will need the following items to set up your cDAQ chassis.
Figure 1-3. Installation Supply List

1
2
3
4

1

2

5

6

Host Computer Running Windows
Application Software, such as LabVIEW, if not
already installed
NI-DAQmx Driver
cDAQ-9185/9189 Chassis

3

7
5
6
7
8

4

8

C Series Module(s)
Shielded Category 5 Ethernet Cable
Power Supply or Power Connector
External Power Supply (if using the power
connector instead of the included power supply)

Note Check the NI-DAQmx driver and application software readme files for
specific version compatibility with your host computer.
Note You can either use a shielded straight-through Category 5 Ethernet cable or
an Ethernet crossover cable to connect the cDAQ chassis directly to your computer.
Note When operating the cDAQ chassis in hazardous locations, you must use the
power connector with an external power supply rated for hazardous locations. The
© National Instruments
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power supply included in the cDAQ chassis kit is intended only for desktop use. For
all other applications use the included 2-position power connector plug and a power
supply rated for your application power requirements. Visit ni.com to find
hazardous locations-certified power supplies.
When operating the cDAQ chassis in temperatures below 0 °C, you must use
the PS-15 power supply or another power supply rated for below 0 °C.

Note

Installing the cDAQ Chassis
The cDAQ chassis and C Series module(s) are packaged separately.
Refer to Figure 1-1 or 1-2 while completing the following assembly steps.
1.

Install the application software (if applicable), as described in the installation instructions
that accompany your software.

2.

Install NI-DAQmx. Insert the software media. If the NI-DAQmx installer does not open
automatically, select Start»Run. Enter x:\autorun.exe, where x is the drive letter.
Complete the instructions.

3.

Register your NI hardware online at ni.com/register when prompted.

4.

The last dialog box opens with the following options.

5.

•

Restart Later to install more NI software or documentation.

•

Shut Down or Restart if you are ready to install your device.

•

Restart if you are using a system running the LabVIEW Real-Time Module.
Download NI-DAQmx to the target using MAX. Refer to the MAX Remote Systems
Help by selecting Help»Help Topics»Remote Systems in MAX.

If you have problems installing your software, go to ni.com/support/daqmx.
Note Table 1-1 lists the earliest NI-DAQmx support version for each cDAQ
Ethernet chassis.

Table 1-1. cDAQ Chassis NI-DAQmx Software Support
cDAQ Chassis

Earliest NI-DAQmx Version Support

cDAQ-9185

NI-DAQmx 17.1

cDAQ-9189

NI-DAQmx 17.1

The NI-DAQmx software is included on the disk shipped with your kit and is available for
download at ni.com/drivers. The documentation for NI-DAQmx is available after
installation from Start»All Programs»National Instruments»NI-DAQmx. Other
NI documentation is available from ni.com/manuals.
1-6
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6.

(Optional) Mount the cDAQ chassis to a panel, wall, or DIN rail, or attach the desktop
mounting kit, as described in the Mounting the cDAQ-9185/9189 section.

7.

Attach a ring lug to a 1.31 mm2 (16 AWG) or larger wire. Connect the ring lug to the chassis
ground terminal on the cDAQ chassis using the chassis grounding screw as shown in
Figure 1-4. Attach the other end of the wire to the grounding electrode system of your
facility. Refer to the Chassis Grounding Screw section for more information about making
this connection.
If you use shielded cabling to connect to a C Series module with a plastic
connector, you must attach the cable shield to the chassis grounding terminal using
1.31 mm2 (16 AWG) or larger wire. Use shorter wire for better EMC performance.

Note

Figure 1-4. Ring Lug Attached to Chassis Ground Terminal

8.

Make sure that no signals are connected to the C Series module.

9.

Align the C Series module with the cDAQ chassis slot.

© National Instruments
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10. Squeeze both C Series module latches, insert the module into the module slot, and press
until both latches lock the module in place.
Figure 1-5. Inserting the C Series Module(s)
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11. Wire the C Series module as indicated in the C Series module documentation.
Note Connect I/O cable shields to the chassis grounding screw, shown in
Figure 1-4, unless otherwise specified in the C Series module documentation. Refer
to the Chassis Grounding Screw section for more information about making this
connection.

12. Connect one end of the Ethernet cable to an Ethernet port on the chassis, and the other end
directly to your computer or any network connection on the same subnet as your computer.
Refer to the Ethernet Cabling section for information about the Ethernet cable.
13. Power the chassis using the included power supply or the included power connector with
an external 9 V DC to 30 V DC power source. For information about wiring your external
power source to the power connector, refer to the Wiring External Power to the cDAQ
Chassis section. The cDAQ chassis requires an external power supply that meets the
specifications listed in the specifications document for your cDAQ chassis.
Note When operating the cDAQ-9185/9189 in hazardous locations, you must use
the power connector with an external power supply rated for hazardous locations.
The power supply included in the cDAQ-9185/9189 kit is intended only for desktop
use. For all other applications use the included 2-position power connector plug and
a power supply rated for your application power requirements. Visit ni.com to find
hazardous locations-certified power supplies.

1-8

|

ni.com

cDAQ-9185/9189 User Manual

Figure 1-6. Connecting Ethernet and Power to the Chassis
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The POWER and STATUS LEDs light. The POWER LED lights as long as power is being
supplied to the cDAQ chassis. The STATUS LED turns off after firmware boots. Refer to
the LEDs section for information about the LEDs on the cDAQ chassis.
14. To add the chassis to your software configuration, open NI MAX on your Windows host
computer. Expand Devices and Interfaces»Network Devices.
Figure 1-7. Network Devices in MAX

•

If the chassis is on your local subnet, the chassis automatically appears in the list of
available devices. Right-click the cDAQ chassis and select Add Device.

•

If the chassis is not on your local subnet, right-click Network Devices and select Find
Network NI-DAQmx Devices.

© National Instruments
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15. In the Find Network NI-DAQmx Devices dialog box that opens, do one of the following:
•

Check the box that corresponds to your chassis in the Hostname column.
Figure 1-8. Find Network NI-DAQmx Devices

•

If you know the chassis IP address, such as 192.168.0.2, enter it into the Add Device
Manually field of the Find Network NI-DAQmx Devices window, and click the +
button.

•

Enter the hostname of the chassis. The default hostname is cDAQ918x-<serial
number>, where the x represents the last digit of your cDAQ chassis model number.

16. Click Add Selected Devices.
The cDAQ chassis icon changes from white to blue/grey, indicating that it is recognized and
present on the network.
Figure 1-9. MAX Icons and States
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If your chassis does not appear in Available Devices, click Refresh List. If the chassis still
does not appear, try the following:
•

If you connected the cDAQ chassis directly to your computer, ensure your network
card is configured to obtain an IP address automatically, then click Refresh List.
Note If you connected the cDAQ chassis directly to your computer, the setup time
may be longer. Wait 30 to 60 seconds after the STATUS LED turns off, then click
Refresh List.

•

Contact your system administrator to confirm that the network is working and that a
firewall is not interfering with discovery. For additional troubleshooting resources for
the cDAQ chassis, refer to the Troubleshooting Chassis Connectivity section of this
manual and the Finding a Network DAQ Device in MAX topic in the Measurement &
Automation Explorer Help for NI-DAQmx.

17. If the cDAQ chassis is not reserved automatically, select the chassis and click the Reserve
Chassis button. Refer to the Reserving the Chassis in MAX section for more information.
18. Self-test your chassis in MAX by expanding Devices and Interfaces, right-clicking
NI cDAQ-<model number>, and selecting Self-Test. Self-test performs a brief test to
determine successful chassis installation. When the self-test finishes, a message indicates
successful verification or if an error occurred. If an error occurs, refer to
ni.com/support/daqmx.
19. Run a Test Panel in MAX by expanding Devices and Interfaces» NI cDAQ-<model
number>, right-clicking your C Series module, and selecting Test Panels to open a test
panel for the selected module. Click Start to verify measurement functionality.
Figure 1-10. Running a Test Panel

If the test panel displays an error message, refer to ni.com/support.
Click Close to exit the test panel.

© National Instruments
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Note When in use, the cDAQ chassis may become warm to the touch. This is
normal.

For instructions on networking to a real-time controller, refer to the Connecting to a Real-Time
Controller section.

Wiring External Power to the cDAQ Chassis
Notice To ensure the specified EMC performance, do not connect the power input
to a DC mains supply or to any supply requiring a connecting cable longer than 3 m
(10 ft). A DC mains supply is a local DC electricity supply network in the
infrastructure of a site or building.

The cDAQ chassis requires an external power source as described in the Power Requirements
section of the specifications document for your chassis. Some suggested NI power supplies are
listed in Table 1-7. The cDAQ chassis filters and regulates the supplied power and provides
power to all of the modules. The green POWER LED on the front panel identifies when the
power input is in use.
Complete the following steps to connect a power source to the cDAQ chassis.
1.

Make sure the power source is turned off.

2.

If connected, loosen the connector screw flanges and remove the power screw terminal
connector plug from the cDAQ chassis. Figure 1-11 shows the terminal screws, which
secure the wires in the screw terminals, and the connector screw flanges, which secure the
connector plug on the front panel.
Figure 1-11. Power Screw Terminal Connector Plug

1

3

2

1
2
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C (Negative) Terminal Screw

3

Connector Screw Flanges

Do not tighten or loosen the terminal screws on the power connector while
the power is on.

Caution

3.

1-12

Connect the positive lead of the power source to the V terminal of the power connector plug
and tighten the terminal screw.
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4.

Connect the negative lead of the power source to the C terminal of the power screw
terminal connector plug and tighten the terminal screw.

5.

Install the power connector plug on the front panel of the cDAQ chassis and tighten the
connector screw flanges.

6.

Turn on the external power source.

If the power source is connected to the power connector using long wiring with high DC
resistance, the voltage at the power connector may be significantly lower than the specified
voltage of the power source.
Refer to the Power Requirements section of the specifications document for your chassis for
information about the power supply input range. Refer to the Safety Voltages section of the
specifications document for your chassis for information about the maximum voltage from
terminal to chassis ground.

Connecting to a Real-Time Controller
You can use the cDAQ-9185/9189 chassis as expansion I/O from certain NI Linux Real-Time
controllers. Discover and configure the NI Linux Real-Time controller in NI MAX, then
discover and configure the cDAQ-9185/9189 chassis.
Note When using an NI Real-Time controller as the host, you can only use select
controllers with the NI Linux Real-Time operating system that support NI-DAQmx.
Supported NI Linux Real-Time controllers include the IC-317x, cRIO-9035/9039
Sync, cRIO-904x/905x, or cDAQ-9132/9133/9134/9135/9136/9137 for LabVIEW
Real-Time.1

1

The cDAQ-9138/9139 for LabVIEW Real-Time controllers will not work in this configuration.
© National Instruments |
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To network the cDAQ-9185/9189 to a real-time controller, you need the following items:
Figure 1-12. Installation Supply List
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Host Computer Running Windows
Supported Real-Time Controller
LabVIEW Software, if not already installed
LabVIEW Real-Time Module, if not already
installed
Driver for the Real-Time Controller, if not already
installed

6
7
8
9
10

NI-DAQmx Driver, if not already installed
cDAQ-9185/9189 Chassis
Shielded Category 5 Ethernet Cable
Power Supply or Power Connector
External Power Supply (if using the power
connector instead of the included power supply)

LabVIEW Real-Time 2017 or later required to use the cDAQ-9185/9189
synchronization features.
Note

Complete the following steps.
1.

Install the LabVIEW, LabVIEW Real-Time Module, and driver software on the host
machine as instructed in the getting started or quick start document for the real-time
controller.

2.

Install NI-DAQmx on the host machine if the driver was not installed in step 1.
a.

Insert the software media. If the NI-DAQmx installer does not open automatically,
select Start»Run. Enter x:\autorun.exe, where x is the drive letter. Complete the
instructions.

b.

Register your NI hardware online at ni.com/register when prompted.

c.

Download NI-DAQmx to the target using MAX. Refer to the MAX Remote Systems
Help by selecting Help»Help Topics»Remote Systems in MAX.
If you have problems installing your software, go to ni.com/support/daqmx.
Table 1-2 lists the earliest NI-DAQmx support version for each cDAQ
Ethernet chassis.
Note
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Table 1-2. cDAQ Chassis NI-DAQmx Software Support
cDAQ Chassis

Earliest NI-DAQmx Version Support

cDAQ-9185

NI-DAQmx 17.1

cDAQ-9189

NI-DAQmx 17.1

3.

Set up your real-time controller hardware and install software to it as instructed in the
getting started or quick start document for the real-time controller.

4.

For cRIO and IC controllers, perform a custom installation of the NI-DAQmx feature to the
controller. In MAX, expand Remote Systems»Real-Time Controller and use the
Add/Remove Software option. Select the custom installation option and the NI-DAQmx
feature, then follow the prompts to complete the installation.

5.

Connect one end of the Ethernet cable to an Ethernet port on the chassis, and the other end
to a switch or network connection on the same subnet as your real-time controller, or
directly to an open network port on your real-time controller. For more information about
the recommended configurations for networking the cDAQ chassis in a real-time system,
refer to the Topology Options section of Chapter 2, Networking.

6.

Power the chassis using the included power supply or the included power connector with
an external 9 V DC to 30 V DC power source.

7.

To add the chassis to the software configuration on the real-time target, open NI MAX on
the host computer. In the MAX configuration tree, expand Remote Systems»Real-Time
Controller»Devices and Interfaces»Network Devices.

8.

Click Add Network Device, and then Find Network NI-DAQmx Devices.

9.

In the Find Network NI-DAQmx Devices dialog box that opens, do one of the following:
•

Check the box that corresponds to your chassis in the Hostname column.

•

If you know the chassis IP address—such as 192.168.0.2—enter it into the
Add Device Manually field, and click the + button.

•

Enter the hostname of the chassis; the default hostname is cDAQ918x-<serial
number>, where the x represents the last digit of your cDAQ chassis model number.

If your chassis does not appear in Available Devices, click Refresh List. If the chassis still
does not appear, contact your system administrator to confirm that the network is working
and that a firewall is not interfering with discovery. For additional troubleshooting
resources for the cDAQ chassis, refer to the Troubleshooting Chassis Connectivity section
of this manual and the Finding a Network DAQ Device in MAX topic in the Measurement
& Automation Explorer Help for NI-DAQmx.
10. Click Add Selected Devices. The cDAQ chassis is added under the real-time controller in
the MAX configuration tree.

© National Instruments |
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Figure 1-13. Adding the cDAQ Chassis to the Real-Time Controller in MAX

11. If the cDAQ chassis is not reserved automatically, select the chassis and click the Reserve
Chassis button. Refer to the Reserving the Chassis in MAX section for more information.
After the chassis is reserved by the real-time controller, the modules in the chassis are
visible in the MAX configuration tree.
Figure 1-14. Reserved cDAQ Chassis View in MAX
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12. Self-test your chassis in MAX by expanding the real-time controller»Devices and
Interfaces»Network Devices, right-clicking NI cDAQ-<model number>, and selecting
Self-Test. Self-test performs a brief test to determine successful chassis installation. When
the self-test finishes, a message indicates successful verification or if an error occurred. If
an error occurs, refer to ni.com/support/daqmx.
13. Run a Test Panel in MAX by expanding the real-time controller»Devices and Interfaces»
Network Devices»NI cDAQ-<model number>, right-clicking the C Series module, and
selecting Test Panels to open a test panel for the selected module.
If the test panel displays an error message, refer to ni.com/support.
Click Close to exit the test panel.

Troubleshooting Chassis Connectivity
If your cDAQ chassis becomes disconnected from the network, try the following:
•

After moving the chassis to a new network, NI-DAQmx may lose connection to the chassis.
In this case, click Reconnect to provide NI-DAQmx with the new hostname or IP address.

•

The cDAQ chassis icon indicates whether it is recognized and present on the network. If a
connected chassis appears as disconnected in the configuration tree in MAX, select
Self-Test or Reset Chassis. If successful, the chassis icon changes to blue/grey.
Figure 1-15. MAX Icons and States
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For additional troubleshooting resources for the cDAQ chassis, refer to the Finding a Network
DAQ Device in MAX topic in the Measurement & Automation Explorer Help for NI-DAQmx.

Reserving the Chassis in MAX
When the cDAQ chassis is connected to a network, multiple users can access the chassis. To
perform any DAQ functionality on the C Series modules, including reset chassis and self-test,
you must reserve the cDAQ chassis in MAX. Figure 1-15 depicts the chassis state icons in
MAX: an unreserved chassis or chassis reserved by another host appear with an X and reserved
chassis appear as blue/grey. Only one user at a time can reserve the cDAQ chassis.
If the cDAQ chassis was not reserved automatically after it was added (Add Device), you can
reserve the cDAQ chassis in MAX by expanding Devices and Interfaces»Network Devices,
selecting the chassis, and clicking the Reserve Chassis button. The Override Reservation
© National Instruments |
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dialog box appears when you attempt to explicitly reserve a chassis. Agreeing to override the
reservation forces the cDAQ chassis to be reserved by the current user.

Mounting the cDAQ-9185/9189
To ensure proper functionality during use at the maximum ambient temperature of 70 °C, you
must mount the cDAQ chassis in the reference mounting configuration shown in the following
image. Mounting the cDAQ chassis in the reference mounting configuration ensures that your
system will operate correctly across the full operating temperature range and provide optimal
C Series module accuracy. Observe the following guidelines to mount the cDAQ chassis in the
reference mounting configuration.
Figure 1-16. cDAQ Chassis Reference Mounting Configuration (cDAQ-9189 Shown)
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Note

Panel mounting substrate options:

•

Mount the cDAQ chassis directly to a metallic surface that is at least 1.6 mm
(0.062 in.) thick and extends a minimum of 101.6 mm (4 in.) beyond all edges of
the device.

•

Use the NI 9904 or NI 9905 Panel Mounting Kit to mount the cDAQ chassis to a
metallic surface that is at least 1.6 mm (0.062 in.) thick and extends a minimum
of 101.6 mm (4 in.) beyond all edges of the device.

Before using any of these mounting methods, record the serial number from the back of the
cDAQ chassis so that you can identify the cDAQ chassis in MAX. You will be unable to read
the serial number after you mount the cDAQ chassis.

Mounting Requirements
Your installation must meet the following requirements for cooling and cabling clearance. Allow
25.4 mm (1.00 in.) on all sides of the cDAQ chassis for air circulation, as shown in the following
figure.
Figure 1-17. Figure 9. cDAQ Chassis Cooling Dimensions (cDAQ-9189 Shown)
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Allow the appropriate space in front of C Series modules for cabling clearance, as shown in the
following figure. The different connector types on C Series modules require different cabling
clearances. For a complete list of cabling clearances for C Series modules, visit ni.com/info
and enter the Info Code crioconn.
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Figure 1-18. cDAQ Chassis Cabling Clearance (cDAQ-9189 Shown)
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29.1 mm (1.14 in.)

Measure the ambient temperature at each side of the cDAQ chassis, 63.5 mm (2.50 in.) from the
side and 38.1 mm (1.50 in.) forward from the rear of the cDAQ chassis, as shown in the
following figure.
Figure 1-19. cDAQ Chassis Ambient Temperature Location (cDAQ-9189 Shown)
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Mounting the cDAQ Chassis Directly on a Flat Surface
For environments with high shock and vibration, NI recommends mounting the cDAQ chassis
directly on a flat, rigid surface using the mounting holes in the cDAQ chassis. This mounting
technique requires M4 screws appropriate for the surface (two M4 screws for the cDAQ-9185
or three M4 screws for the cDAQ-9189) and a screwdriver.
Complete the following steps to mount the cDAQ chassis directly on a flat surface.
1.

Prepare the surface for mounting the cDAQ chassis using the surface mounting dimensions
listed in Figure or 1-21.
Figure 1-20. cDAQ-9185 Surface Mounting Dimensions
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Figure 1-21. cDAQ-9189 Surface Mounting Dimensions
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2.

Align the cDAQ chassis on the surface.

3.

Fasten the cDAQ chassis to the surface using the M4 screws appropriate for the surface.
Tighten the screws to a maximum torque of 1.3 N · m (11.5 lb · in.).

© National Instruments |

1-21

Chapter 1

Getting Started with the cDAQ Chassis

Figure 1-22. Mounting the cDAQ Chassis on a Flat Surface (cDAQ-9189 Shown)
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Mounting the cDAQ Chassis on a Panel with a Panel
Mounting Kit
You can use a panel mounting kit to mount the cDAQ- chassis on a panel. This mounting
technique requires a Phillips #2 screwdriver and a panel mounting kit (NI 9904 panel mounting
kit, 779097-01, for the cDAQ-9185, or NI 9905 panel mounting kit, 779558-01, for the
cDAQ-9189).
Complete the following steps to mount the cDAQ chassis on a panel.
1.

Align the cDAQ chassis and the panel mount plate.

2.

Fasten the panel mounting plate to the cDAQ chassis using the screwdriver and screws.
Tighten the screws to a maximum torque of 1.3 N · m (11.5 lb · in.).
(NI 9904) Use two M4x25 screws, included in the kit.
(NI 9905) Use three M4x23 screws, included in the kit.

3.

Fasten the panel mounting plate to the surface using the screwdriver and screws that are
appropriate for the surface. The maximum screw size is M5 or number 10.
Figure 1-23. Mounting the Chassis on a Panel (cDAQ-9189 Shown)
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The following figures show the panel mounting dimensions for the cDAQ-9185 and
cDAQ-9189.
Figure 1-24. cDAQ-9185 Panel Mounting Dimensions
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Figure 1-25. cDAQ-9189 Panel Mounting Dimensions
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Alternate Mounting Configurations
The maximum operating temperature of 70 °C may be reduced for any mounting configuration
other than the reference mounting configuration. A 10 °C (18 °F) reduction in maximum
operating temperature is sufficient for most alternate mounting configurations. Follow the
mounting requirements for all mounting configurations.
The published accuracy specifications, although not guaranteed for alternate mounting
configurations, may be met depending on the system power and the thermal performance of the
alternate mounting configuration.
Contact NI for further details regarding the impact of common alternate mounting
configurations on maximum operating temperature and module accuracy.

Mounting the cDAQ Chassis on a DIN Rail
You can use the NI DIN rail mounting kit to mount the cDAQ chassis on a standard 35-mm DIN
rail. This mounting technique requires a Phillips #2 screwdriver and a panel mounting kit
(NI 9912 DIN rail mounting kit, 779019-01, for the cDAQ-9185, or NI 9915 DIN rail mounting
kit, 779018-01, for the cDAQ-9189).
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Complete the following steps to mount the cDAQ chassis on a DIN rail.
1.

Align the cDAQ chassis and the DIN rail clip.

2.

Fasten the DIN rail kit to the cDAQ chassis using the screwdriver and M4x25 screws.
Tighten the screws to a maximum torque of 1.3 N · m (11.5 lb · in.).
Figure 1-26. Attaching the Chassis to a DIN Rail Clip (cDAQ-9189 Shown)

You must use the screws provided with the NI DIN rail kit because they are the correct
depth and thread for the DIN rail clip.
Figure 1-27. Clipping the Chassis on a DIN Rail

3.

Insert one edge of the DIN rail into the deeper opening of the DIN rail clip.

4.

Press down firmly to compress the spring until the clip locks in place on the DIN rail.
Ensure that no C Series modules are in the cDAQ chassis before removing it
from the DIN rail.

Note
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Mounting the Chassis on a Rack
NI offers the following rack-mount kits that you can use to mount the cDAQ chassis and other
DIN rail-mountable equipment on a standard 482.6 mm (19 in.) rack:
•

NI 9910 Sliding Rack-Mounting Kit, 779102-01

•

NI Rack-Mounting Kit, 781989-01
Note You must order the NI 9912 DIN rail mounting kit, 779019-01, or NI 9915
DIN rail mounting kit, 779018-01, in addition to a rack-mount kit.

Mounting the cDAQ Chassis on a Desktop
You can use the NI 9901 desktop mounting kit, part number 779473-01, to mount the cDAQ
chassis on a desktop. This mounting technique requires Phillips #1 and #2 screwdrivers and the
NI 9901 desktop mounting kit, 779473-01.
Complete the following steps to mount the cDAQ chassis on a desktop.
1.

Use a #1 Phillips screwdriver to remove the two screws from the back of the chassis on the
front-panel side.

2.

Use the screwdriver and the two M3x20 screws to attach the adapter bracket to the chassis.

3.

Align one of the end brackets with the mounting hole at one of the ends of the chassis.

4.

Use a #2 Phillips screwdriver to tighten the captive screw on the end bracket.
Figure 1-28. Attaching the Desktop Mounting Kit (cDAQ-9189 Shown)
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5.

Repeat steps 2 and 3 to attach the other end bracket to the other end of the chassis.
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The following figures show the desktop mounting kit dimensions.
Figure 1-29. Desktop Mounting Front Dimensions (cDAQ-9189 Shown)
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Figure 1-30. Desktop Mounting Side Dimensions

127.0 mm
(5.00 in.)

130.0 mm
(5.12 in.)

Dimensions
The following figures show the front and side dimensions of the cDAQ-9185 and cDAQ-9189.
For detailed dimensional drawings and 3D models, visit ni.com/dimensions and search for
cDAQ-9185 or cDAQ-9189.
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Figure 1-31. cDAQ-9185 Dimensions
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Figure 1-32. cDAQ-9189 Dimensions
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cDAQ Chassis Features
The cDAQ chassis features a chassis grounding screw, LEDs, reset button, two Ethernet ports,
power connector, and one PFI SMB connector. Refer to Figure 1-1 or 1-2 for locations of the
cDAQ chassis features.

LEDs
The statuses for the POWER, STATUS, and ACTIVE LED indicators on the cDAQ chassis are
listed in Table 1-3.
Table 1-3. LED State/Chassis Status
LED

POWER

STATUS

ACTIVE

Color

Green

Yellow

Green

LED State

Chassis Status

On

Power on

Off

Power off

On

Chassis firmware booting, updating, or
resetting to factory default

Off

Normal operation

3 Blinks

Firmware image corrupted. Contact NI for
support on corrupted firmware.

On

A DAQmx task is running on the chassis

Off

A DAQmx task is not running on the
chassis

Ethernet Ports
The cDAQ-9185/9189 chassis has two tri-speed RJ-45 Ethernet ports—Ethernet Port 1 and
Ethernet Port 2—as shown in Figure 1-1 or 1-2. You can use a shielded straight-through
Category 5 Ethernet or an Ethernet crossover cable with either of the Ethernet ports to network
your chassis to a computer host, NI Linux Real-Time controller, cDAQ chassis, FieldDAQ
device, or any network connection on the same subnet. Refer to Chapter 2, Networking, for more
information about using these ports in various topologies.
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Ethernet LEDs
The Ethernet port has two LEDs—10/100/1000 and LINK/ACT—described in Table 1-4.
Table 1-4. Ethernet LED Indications
LED

10/100/1000

Color

Chassis Status

Yellow

On

Connected at 1000 Mbps

Green

On

Connected at 100 Mbps

Off

No Ethernet connection or 10 Mbps
connection

On

Ethernet link

Off

No Ethernet connection

Blinking

Ethernet activity

—
LINK/ACT

LED State

Green

Ethernet Cabling
Table 1-5 shows the shielded Ethernet cable wiring connections for both straight-through and
crossover cables.
Table 1-5. Ethernet Cable Wiring Connections
Connector 2

1-30

Pin

Connector 1

Straight-Through

Crossover

1

white/orange

white/orange

white/green

2

orange

orange

green

3

white/green

white/green

white/orange

4

blue

blue

blue

5

white/blue

white/blue

white/blue
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Table 1-5. Ethernet Cable Wiring Connections (Continued)
Connector 2
Pin

Connector 1

Straight-Through

Crossover

6

green

green

orange

7

white/brown

white/brown

white/brown

8

brown

brown

brown

Connector 1
Pin 1

Connector 2
Pin 8

Pin 1

Pin 8

Reset Button
The cDAQ chassis is equipped with a reset button.
Pressing the reset button results in the following chassis responses:
•

When pressed for less than five seconds, the chassis reboots with the current configuration.

•

When pressed for five seconds or longer, the STATUS LED lights. When released, the
chassis reboots into factory default mode, which returns the chassis user configuration to
the factory-set defaults listed in Table 1-6.
Table 1-6. NI cDAQ Chassis Default Settings
Attribute

Value

Hostname

cDAQ918x-<serial number>

IP

DHCP or Link Local
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Table 1-6. NI cDAQ Chassis Default Settings (Continued)
Attribute

Value

Comment

Empty

Default Login

User name = admin
Password = no password required

Power Connector
The cDAQ chassis ships with the following:
•

2-position power screw terminal connector plug (for use with an external power source)

•

Power supply
Note When operating the cDAQ-9185/9189 in hazardous locations, you must use
the power connector with an external power supply rated for hazardous locations.
The power supply included in the cDAQ-9185/9189 kit is intended only for desktop
use. For all other applications use the included 2-position power connector plug and
a power supply rated for your application power requirements. Visit ni.com to find
hazardous locations-certified power supplies.

Refer to the specifications document for your chassis for information about the power connector.

PFI 0 SMB Connector
Refer to the PFI section of Chapter 5, Digital Input/Output and PFI, for information about the
SMB connector for PFI 0.

Internal Ethernet Switch
Refer to the Internal Ethernet Switch section of Chapter 2, Networking, for information about
the internal ethernet switch.

Chassis Grounding Screw
To ensure the specified EMC performance, the cDAQ chassis must be
connected to the grounding electrode system of your facility using the chassis ground
terminal.

Notice

The wire should be 1.31 mm2 (16 AWG) or larger solid copper wire with a maximum length of
1.5 m (5 ft). Attach the wire to the earth ground of the facility’s power system. For more
information about earth ground connections, refer to the Grounding for Test and Measurement
Devices document by going to ni.com/info and entering the Info Code emcground.
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Note If you use shielded cabling to connect to a C Series module with a plastic
connector, you must attach the cable shield to the chassis grounding terminal using
1.31 mm2 (16 AWG) or larger wire. Use shorter wire for better EMC performance.

Time-Based Features
cDAQ-9185/9189 chassis feature automatic network-based synchronization with compatible
networks and IEEE 802.1AS-capable NI Linux Real-Time controllers. The SYNC logo on the
chassis front panel, shown in Figures 1-1 and 1-2, indicate that the chassis are capable of
hardware-based synchronization over a network.
The chassis can be daisy-chained to each other or connected to external networks that support
IEEE 802.1AS synchronization, and all chassis timebases will be automatically synchronized.
Refer to Chapter 2, Networking, and the Synchronization across a Network section of Chapter 7,
Digital Routing, Clock Generation, and Synchronization, for more information about supported
topologies and other technical requirements.
Network-synchronized chassis can also take advantage of time-based synchronization features
in NI-DAQmx. Certain triggers and timestamps can be specified in terms of time of day.
Time-based triggers and timestamps and multichassis tasks (spanning multiple
network-synchronized cDAQ chassis) can help simplify programming for large systems.
Time triggers and timestamps can be specified in Host Time or I/O Device Time, depending on
the needs of your application.
•

I/O Device Time—The time the cDAQ-9185/9189 uses internally. This time is determined
by the network configuration and is shared by all 802.1AS network-synchronized devices
on your subnet.

•

Host Time—The time on your Windows computer or NI Linux Real-Time controller. This
is usually the current global time, and is provided by a local real-time clock or a network
time protocol (NTP) server.

NI-DAQmx automatically translates from Host Time to I/O Device Time as necessary. The
accuracy of this translation depends on the relationship between these times and can reduce the
relative accuracy of time triggers and timestamps across multiple devices. For maximum
accuracy, use an NI Linux Real-Time controller as the host in a supported topology. However,
NI-DAQmx guarantees that two tasks configured to start at the same host time always start at
the same I/O Device Time in all scenarios, preserving precise synchronization between chassis
in this common use case. Refer to the Timestamps and Time Triggering topics in the NI-DAQmx
Help for more information on accessing time-based features in the NI-DAQmx API.
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Watchdog Timer
The watchdog timer is a software-configurable feature used to set critical outputs to expiration
states in the event of a software failure, a system crash, or any other loss of communication
between the application and the cDAQ chassis.
When the watchdog timer is enabled, if the cDAQ chassis does not receive a watchdog reset
software command within the time specified for the watchdog timer, the outputs go to a
user-defined expiration state and remain in that state until the watchdog timer is disarmed by a
device reset. After the watchdog timer expires, the cDAQ chassis cannot perform any operation
until the cDAQ chassis is reset.
You can use the watchdog timer to do the following:
•
Set a timeout period to specify the amount of time that must elapse before the
watchdog timer expires
•

Set to expire upon loss of network connectivity

The counter on the watchdog timer is configurable up to (232 - 1) × 25 ns (approximately
107 seconds) before it expires. Analog output, digital output, and counter output channels can
be configured to transition to an expiration state when a watchdog timer expires.
Resetting the chassis after a watchdog expiration event results in all module outputs defaulting
to power up or startup states as defined in the module specifications.
Resetting the chassis after a watchdog expiration event may result in
undefined transient behavior on the outputs of the NI 9269 and NI 9474 modules.
Consult the module specifications for the expected I/O behavior.
Note

Restarting or re-reserving the chassis may lead to undefined transient
behavior on the outputs of any modules, so these operations are not recommended as
means of a watchdog expiration event recovery.
Note

No other operations may be running on the cDAQ chassis while the watchdog
timer task is being started; this includes all DAQmx tasks, calibration of modules,
and routing and configuration of signals on the chassis. After the watchdog timer task
starts, DAQmx tasks can be started and stopped and other operations can be
performed.
Note

Firmware
Firmware can be updated through NI MAX or the web interface to the chassis. For cDAQ
firmware information and updates, visit ni.com/info and enter the Info Code cdaqfw.
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Cables and Accessories
Table 1-7 contains information about cables and accessories available for the cDAQ chassis.
For a complete list of cDAQ chassis accessories and ordering information, refer to the pricing
section of the NI cDAQ-9185/9189 product page at ni.com.
Table 1-7. Cables and Accessories
Accessory

Part Number

cDAQ
Chassis

NI PS-15 power supply (24 VDC, 5 A,
100 to 120/200 to 240 VAC input, -25 to 70 °C)

781093-01

cDAQ-9185
cDAQ-9189

NI PS-9 desktop power supply
(12 VDC, 1.25 A, 100 to 240 VAC input, 0 to
70 °C, derated 0.27 W/°C above 40 °C)

780703-01

cDAQ-9185
cDAQ-9189

NI 9901 desktop mounting kit

779473-01

cDAQ-9185
cDAQ-9189

NI 9904 panel mount kit

779097-01

cDAQ-9185

NI 9905 panel mount kit

779558-01

cDAQ-9189

NI 9912 DIN rail mounting kit

779019-01

cDAQ-9185

NI 9915 DIN rail mounting kit

779018-01

cDAQ-9189

Carrying Handle for CompactRIO & CompactDAQ

786744-01

cDAQ-9185
cDAQ-9189

2-pos screw terminal kit for power supply
connection, qty 4

780702-01

cDAQ-9185
cDAQ-9189

151733-02/05/10

cDAQ-9185
cDAQ-9189

CAT-5E Ethernet cable, shielded,
(2 m, 5 m, and 10 m lengths)

Removing Modules from the cDAQ Chassis
Complete the following steps to remove a C Series module from the cDAQ chassis.
1.

Make sure that no I/O-side power is connected to the module. If the system is in a
nonhazardous location, the chassis power can be on when you remove modules.

2.

Squeeze the latches on both sides of the module and pull the module out of the chassis.

Maintenance
If you need to clean the chassis, wipe it with a dry towel.
© National Instruments |
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Using the cDAQ Chassis
The cDAQ system consists of three parts: C Series module(s), the cDAQ module interface, and
the STC3, as shown in Figure 1-33. These components digitize signals, perform D/A
conversions to generate analog output signals, measure and control digital I/O signals, and
provide signal conditioning.
Figure 1-33. cDAQ-9185/9189 Chassis Block Diagram
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C Series
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C Series Module
National Instruments C Series modules provide built-in signal conditioning and connectivity,
such as screw terminal, spring terminal, BNC, DSUB, or RJ-50 connectors. A wide variety of
I/O types are available, allowing you to customize the cDAQ system to meet your application
needs.
C Series modules are hot-swappable and automatically detected by the cDAQ chassis.
I/O channels are accessible using the NI-DAQmx driver software.
Because the modules contain built-in signal conditioning for extended voltage ranges or
industrial signal types, you can usually make your wiring connections directly from the C Series
modules to your sensors/actuators. In most cases, the C Series modules provide
channel-to-ground and channel-to-channel isolation.
For more information about which C Series modules are compatible with the cDAQ chassis, go
to ni.com/info and enter the Info Code rdcdaq.
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cDAQ Module Interface
The cDAQ module interface manages data transfers between the STC3 and the C Series
modules. The interface also handles autodetection, signal routing, and synchronization.

STC3
The STC3 features independent high-speed data streams; flexible AI, AO, and DIO sample
timing, triggering, PFI signals for multi-device synchronization, flexible counter/timers with
hardware gating, digital waveform acquisition and generation, and static DIO.
•

•

AI, AO, and DIO Sample Timing—The STC3 contains advanced AI, AO, and DIO
timing engines. A wide range of timing and synchronization signals are available through
the PFI lines. Refer to the following sections for more information about the configuration
of these signals:
–

The Analog Input Timing Signals section of Chapter 3, Analog Input

–

The Analog Output Timing Signals section of Chapter 4, Analog Output

–

The Digital Input Timing Signals section of Chapter 5, Digital Input/Output and PFI

–

The Digital Output Timing Signals section of Chapter 5, Digital Input/Output and PFI

Triggering Modes—The cDAQ chassis supports different trigger modes, such as start
trigger, reference trigger, and pause trigger with analog, digital, or software sources. Refer
to the following sections for more information:
–

The Analog Input Triggering Signals section of Chapter 3, Analog Input

–

The Analog Output Triggering Signals section of Chapter 4, Analog Output

–

The Digital Input Triggering Signals section of Chapter 5, Digital Input/Output and
PFI

–

The Digital Output Triggering Signals section of Chapter 5, Digital Input/Output and
PFI

•

Independent Data Streams—The cDAQ chassis supports seven independent high-speed
data streams, which allow for up to seven simultaneous hardware-timed tasks, such as
analog input, analog output, buffered counter/timers, and hardware-timed digital
input/output.

•

PFI Signals—The PFI signals provide access to advanced features such as triggering,
synchronization, and counter/timers. You can also enable a programmable debouncing
filter on each PFI signal that, when enabled, samples the input on each rising edge of a filter
clock. PFI signals are available through parallel digital input and output modules installed
in up to two chassis slots and through the two PFI terminals provided on the cDAQ chassis.
Refer to the PFI section of Chapter 5, Digital Input/Output and PFI, for more information.
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•

Flexible Counter/Timers—The cDAQ chassis includes four general-purpose 32-bit
counter/timers that can be used to count edges, measure pulse-widths, measure periods and
frequencies, and perform position measurements (encoding). In addition, the
counter/timers can generate pulses, pulse trains, and square waves with adjustable
frequencies. You can access the counter inputs and outputs using parallel digital I/O
modules installed in up to two slots, or by using the two chassis PFI terminals provided on
the cDAQ chassis. Refer to Chapter 6, Counters, for more information.

Ethernet Network Interface
The Ethernet Network Interface transfers analog input, analog output, and digital I/O data
between the STC3 and the network. It gathers the data into TCP/IP packets that can be sent
across the network and interpreted by the host.

Internal Ethernet Switch and Ethernet Ports
The Ethernet switch exposes two Ethernet ports to the user. Either port can be used to connect
the chassis to the network. The two ports can be used to connect multiple chassis in a daisy-chain
topology. The switch also provides synchronization features that enable analog input, analog
output, and counter/timers to be synchronized to other chassis across a distributed network.
Refer to Chapter 2, Networking, for information about cDAQ chassis daisy-chain topology and
the internal Ethernet switch.

2

Networking

This chapter explores the internal Ethernet switch and recommended networking topologies for
the cDAQ chassis.
Refer to the Installing the cDAQ Chassis and Connecting to a Real-Time
Controller sections of Chapter 1, Getting Started with the cDAQ Chassis, for
information about connecting the cDAQ chassis to a host computer or host real-time
controller.
Note

Internal Ethernet Switch
The cDAQ-9185/9189 chassis feature a full hardware-accelerated internal Ethernet switch for
greater performance, wiring flexibility, and compatibility over standard Ethernet ports. The
Ethernet switch exposes two Ethernet ports to the user. Either port can be used to connect the
chassis to the network. The two ports can be used to connect multiple devices in a daisy-chain
topology. The switch also supports the Rapid Spanning Tree Protocol (RSTP) algorithm,
enabling ring topologies. Refer to the Topology Options section for more details.

IEEE 802.1AS-2011 Precision Time Protocol
The internal Ethernet switch is an 802.1AS time-aware bridge, compatible with the
IEEE 802.1AS-2011 Precision Time Protocol. It can synchronize local analog input, analog
output, digital input/output, and counter/timers to other devices across an 802.1AS subnet. It can
also serve as a bridge, synchronizing 802.1AS devices that are attached to each of the two ports.
Refer to the Synchronization across a Network section, of Chapter 7, Digital Routing,
Clock Generation, and Synchronization, for more details.

IEEE 802.1Q Rapid Spanning Tree Protocol (RSTP)
It is possible to create loops in a network using the cDAQ-9185/9189. To prevent these loops
from disrupting the network, the cDAQ chassis implements the IEEE 802.1Q Rapid Spanning
Tree Protocol (RSTP). Using this protocol, each cDAQ chassis is able to find the shortest path
for incoming packets to reach the rest of the network. When multiple paths exist, this adds a form
of redundancy. If a link fails, the protocol automatically switches to use the redundant link. This
process can take several seconds in some cases.
To gain these benefits on external switches connected to the cDAQ chassis, IEEE 802.1Q
(RSTP) must be enabled. All external switches must be configured to allow the cDAQ chassis
to transmit RSTP packets, known as Bridge Protocol Data Units (BPDU). If any switch has a
feature—such as “BPDU guard”—enabled, the port connected to the cDAQ chassis is disabled
© National Instruments
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and communication is lost. Refer to the documentation for your external switch for information
about enabling RSTP and disabling BPDU guards on the switch.

IEEE 1588-2008 Protocol
Note

IEEE 1588 protocol is supported in NI-DAQmx 18.1 and later.

The internal Ethernet switch can be configured to act as a 1588 “boundary clock” implementing
the IEEE 1588 delay request-response default PTP profile (sometimes referred to as “default
profile”). When so configured, it can synchronize local measurement signals to other devices
across an IP subnetwork and can serve as a bridge, synchronizing 1588 devices that are attached
to each of the two ports. Refer to the Synchronization across a Network section, of Chapter 7,
Digital Routing, Clock Generation, and Synchronization, for more details.
Note The IEEE 802.1AS protocol is an IEEE 1588 profile, but is incompatible with
other IEEE 1588 profiles. When cDAQ chassis are using the IEEE 802.1AS protocol
to synchronize they cannot synchronize with devices that use other protocols or
IEEE 1588 profiles and vice versa.

Chassis MAC Addresses
The cDAQ chassis is associated with two MAC addresses—both of which are labeled on the
chassis—device and switch. These MAC addresses are not associated with a particular Ethernet
port, but both addresses can appear on both ports as necessary.
Table 2-1. NI MAX Device and Switch MAC Addresses
Device MAC Address

Switch MAC Address

Associated with the chassis’ IP address

Associated with the internal Ethernet
switch—not associated with the chassis’ IP
address

Used by normal device traffic

Used for Ethernet protocols for network
configuration and synchronization

Listed in MAX

Not listed in MAX

The switch MAC address is used to implement the following switch protocols:
•

IEEE 802.1AS-2011 (Precision Time Protocol)

•

IEEE 802.1Q (Rapid Spanning Tree Protocol [RSTP])

•

IEEE 1588-2008 (Precision Time Protocol)1

1

IEEE 1588 protocol is supported in NI-DAQmx 18.1 and later.
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The switch MAC address only appears in packets exchanged between the switch embedded in
the cDAQ chassis and the next Ethernet device. It will not propagate further in a properly
configured network. For more information about the recommended configurations for
networking the cDAQ chassis, refer to the Topology Options section.

Topology Options
Recommended networking topologies are described in this section.
•

Host—Can be a Windows computer or a real-time controller with the NI Linux Real-Time
operating system, such as the IC-317x, cRIO-9035/9039 Sync, cRIO-904x/905x, or
cDAQ-9132/9133/9134/9135/9136/9137 for LabVIEW Real-Time

•

Node—Can be the cDAQ-9185/9189 chassis or any FieldDAQ device

For more information about designing Ethernet measurement systems, visit ni.com/info and
enter cdaqenet.

Line Topology
In a line topology—also known as daisy-chaining or bus topology—the host communicates
directly with all nodes through one bus line. A standard Ethernet device or switch can be added
to the end of the chain if desired and used as normal. Be aware that these devices will compete
for network bandwidth with the cDAQ chassis. Reliable system design requires awareness of the
bandwidth consumed by each device during operations. This topology offers no redundant links.
Figure 2-1. Line Topology
Host
Node

Node

Node

Networking

Advantages:
•

Simple and inexpensive installation, expansion, and troubleshooting

•

Ideal for low number of nodes. NI recommends a maximum of 15 nodes.

•

No external switch needed

•

Can cover long distances

Disadvantages:
•

Any unpowered nodes and/or node failure disrupts network communication

•

Addition or removal of any node disrupts network communication

•

Failure of any Ethernet cable and/or improper cable termination disrupts network
communication

•

Network performance and synchronization affected when node count exceeds 15. Consider
the Star Topology for systems that require a greater number of nodes.
© National Instruments
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Ring Topology
In a ring topology, the host communicates with all nodes through the most effective path. You
must use an external switch in a ring topology. You must configure the network properly with a
recommended external switch before creating redundant links in the network. Refer to the
External Switch Requirements section for information about what to look for in an external
switch.
Figure 2-1. Ring Topology
Host
Networking

External
Switch

Node

Node

Node

Advantages:
•

Failure of any single Ethernet cable does not disrupt network communication

•

Additional nodes or heavier network traffic affects network performance less than the line
topology

•

Simple installation

•

Ideal for a local networking solution
Network configuration and programming require careful consideration.
Visit ni.com/info and enter cdaqenet for information about exploiting link
redundancy and automatically improving reliability.
Note

Disadvantages:
•

Network traffic patterns can make troubleshooting difficult

•

Requires an external switch

Star Topology
In a star topology, the host communicates directly with each node through the external switch.
You must use an external switch in a star topology; for network synchronization, you must use
an external 802.1AS switch. Redundant links are recommended, but optional, in this topology.
You must configure the network properly with a recommended external switch before creating
redundant links in the network. Refer to the External Switch Requirements section for
information about what to look for in an external 802.1AS switch.
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Figure 2-2. Star Topology
Node

Host
Node
External
Switch

Node
Networking
Redundant Link (optional)

Advantages:
•

Unpowered nodes and/or node failure does not disrupt network communication with other
nodes

•

Failure of any single Ethernet cable does not disrupt network communication when you
have a redundant link

•

Additional nodes or heavier network traffic affects network performance less than the other
topologies

•

Simple installation, expansion, and troubleshooting
Note Network configuration and programming require careful consideration. Visit
ni.com/info and enter cdaqenet for information about exploiting link

redundancy and automatically improving reliability.
Disadvantages:
•

Most costly of the recommended topologies

•

Requires an external switch (external 802.1AS switch for network synchronization)

•

Covers the least distance

Other Topologies
For information about designing Ethernet measurement systems for synchronization, visit
ni.com/info and enter cdaqenet.
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External Switch Requirements
To meet the minimum requirements for successful operation with cDAQ-9185/9189 chassis, any
switch directly connected to the chassis should be compliant with IEEE 802.1Q bridges and
bridged networks
To take advantage of the network synchronization and network redundancy features of the
cDAQ-9185/9189, ensure that your network infrastructure meets certain requirements:
•

IEEE 802.1AS-2011 time-based synchronization support—Automatically synchronizes
timebases and enables the use of time-based triggers, timestamping, and multi-device tasks
between chassis across the network.

•

IEEE 802.1Q (Rapid Spanning Tree Protocol) support—Supports network redundancy
functionality in ring and star topologies
–

Rapid Spanning Tree Protocol (RSTP) enabled

–

Bridge Protocol Data Units (BPDU) Guard disabled

To learn more about recommended network switches and other network configuration best
practices and requirements, visit ni.com/info and enter cdaqenet.
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To perform analog input measurements, install a supported analog input C Series module into
any slot on the cDAQ chassis. The measurement specifications, such as number of channels,
channel configuration, sample rate, and gain, are determined by the type of C Series module
used. For more information and wiring diagrams, refer to the documentation included with your
C Series modules.
The cDAQ chassis has three AI timing engines, which means that three analog input tasks can
be running at a time on a chassis. An analog input task can include channels from multiple analog
input modules. However, channels from a single module cannot be used in multiple tasks.
Multiple timing engines allow the cDAQ chassis to run up to three analog input tasks
simultaneously, each using independent timing and triggering configurations. The three
AI timing engines are ai, te0, and te1.

Analog Input Triggering Signals
A trigger is a signal that causes an action, such as starting or stopping the acquisition of data.
When you configure a trigger, you must decide how you want to produce the trigger and the
action you want the trigger to cause. The cDAQ chassis supports internal software triggering,
external digital triggering, analog triggering, and internal time triggering.
Three triggers are available: Start Trigger, Reference Trigger, and Pause Trigger. An analog or
digital signal can initiate these three trigger actions. Time can also initiate the Start Trigger. Up to
two C Series parallel digital input modules can be used in any chassis slot to supply a digital trigger.
To find your module triggering options, refer to the documentation included with your C Series
modules. For more information about using digital modules for triggering, refer to Chapter 5,
Digital Input/Output and PFI.
Refer to the AI Start Trigger Signal, AI Reference Trigger Signal, and AI Pause Trigger Signal
sections for more information about the analog input trigger signals.

Analog Input Timing Signals
The cDAQ chassis features the following analog input timing signals:
•

AI Sample Clock Signal*

•

AI Sample Clock Timebase Signal

•

AI Start Trigger Signal*

© National Instruments

|

3-1

Chapter 3

Analog Input

•

AI Reference Trigger Signal*

•

AI Pause Trigger Signal*

Signals with an * support digital filtering. Refer to the PFI Filters section of Chapter 5, Digital
Input/Output and PFI, for more information.
Refer to the AI Convert Clock Signal Behavior For Analog Input Modules section for AI Convert
Clock signals and the cDAQ chassis.

AI Sample Clock Signal
A sample consists of one reading from each channel in the AI task. Sample Clock signals the
start of a sample of all analog input channels in the task. Sample Clock can be generated from
external or internal sources as shown in Figure 3-1.
Figure 3-1. AI Sample Clock Timing Options
PFI
Analog Comparison Event
Ctr n Internal Output
PFI
Analog Comparison
Event
80 MHz Timebase
20 MHz Timebase

Sigma-Delta Module Internal Output
AI Sample Clock
Timebase

AI Sample
Clock

Programmable
Clock
Divider

13.1072 MHz Timebase
12.8 MHz Timebase
10 MHz Timebase
100 kHz Timebase

Routing the Sample Clock to an Output Terminal
You can route Sample Clock to any output PFI terminal. Sample Clock is an active high pulse
by default.

AI Sample Clock Timebase Signal
The AI Sample Clock Timebase signal is divided down to provide a source for Sample Clock.
AI Sample Clock Timebase can be generated from external or internal sources. AI Sample Clock
Timebase is not available as an output from the chassis.
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AI Convert Clock Signal Behavior For Analog Input
Modules
Refer to the Scanned Modules, Simultaneous Sample-and-Hold Modules, Delta-Sigma Modules,
and Slow Sample Rate Modules sections for information about the AI Convert Clock signal and
C Series analog input modules.

Scanned Modules
Scanned C Series analog input modules contain a single A/D converter and a multiplexer to
select between multiple input channels. When the cDAQ Module Interface receives a Sample
Clock pulse, it begins generating a Convert Clock for each scanned module in the current task.
Each Convert Clock signals the acquisition of a single channel from that module. The Convert
Clock rate depends on the module being used, the number of channels used on that module, and
the system Sample Clock rate.
The driver chooses the fastest conversion rate possible based on the speed of the A/D converter
for each module and adds 10 µs of padding between each channel to allow for adequate settling
time. This scheme enables the channels to approximate simultaneous sampling. If the AI Sample
Clock rate is too fast to allow for 10 µs of padding, NI-DAQmx selects a conversion rate that
spaces the AI Convert Clock pulses evenly throughout the sample. NI-DAQmx uses the same
amount of padding for all the modules in the task. To explicitly specify the conversion rate, use
the ActiveDevs and AI Convert Clock Rate properties using the DAQmx Timing property
node or functions.

Simultaneous Sample-and-Hold Modules
Simultaneous sample-and-hold (SSH) C Series analog input modules contain multiple A/D
converters or circuitry that allows all the input channels to be sampled at the same time. These
modules sample their inputs on every Sample Clock pulse.

Delta-Sigma Modules
Delta-sigma C Series analog input modules function much like SSH modules, but use A/D
converters that require a high-frequency oversample clock to produce accurate, synchronized
data. Some delta-sigma modules in the cDAQ chassis automatically share a single oversample
clock to synchronize data from all the modules that support an external oversample clock
timebase when they all share the same task. (DSA modules are an example). The cDAQ chassis
supports a maximum of two synchronization pulse signals configured for your system. This
limits the system to two tasks with different oversample clock timebases.
The oversample clock is used as the AI Sample Clock Timebase. The cDAQ chassis supplies
10 MHz, 12.8 MHz, and 13.1072 MHz timebases from which software automatically selects
based on the modules in the task. When delta-sigma modules with different oversample clock
frequencies are used in an analog input task, the AI Sample Clock Timebase can use any of the
available frequencies; by default, the fastest available is used. The sample rate of all modules in
the task is an integer divisor of the frequency of the AI Sample Clock Timebase.
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When one or more delta-sigma modules are in an analog input task, the delta-sigma modules also
provide the signal used as the AI Sample Clock. This signal is used to cause A/D conversion for
other modules in the system, just as the AI Sample Clock does when a delta-sigma module is not
being used.
When delta-sigma modules are in an AI task, the chassis automatically issues a synchronization
pulse to each delta-sigma modules that resets their ADCs at the same time. You can also specify
a specific time for the sync pulse to occur. Because of the filtering used in delta-sigma A/D
converters, these modules usually exhibit a fixed input delay relative to non-delta-sigma
modules in the system. This input delay is specified in the C Series module documentation.
When using multichassis device tasks across multiple chassis that contains channels from
delta-sigma C Series modules ensure that one of those channels is the first in your channel list.

Slow Sample Rate Modules
Some C Series analog input modules are specifically designed for measuring signals that vary
slowly, such as temperature. Because of their slow rate, it is not appropriate for these modules
to constrain the AI Sample Clock to operate at or slower than their maximum rate. When using
such a module in the cDAQ chassis, the maximum Sample Clock rate can run faster than the
maximum rate for the module. When operating at a rate faster than these slow rate modules can
support, the slow rate module returns the same point repeatedly, until a new conversion
completes. In a hardware-timed task, the first point is acquired when the task is committed. The
second point is acquired after the start trigger as shown in Figure 3-2.
Figure 3-2. Sample Clock Timing Example
StartTrigger
1st A/D Conversion
Data from
A/D Conversion
(Slow Module)

2nd A/D Conversion

3rd A/D Conversion

B

A

C

SampleClock
Data Returned
to AI Task

A

A

A

B

B

B

C

For example, if running an AI task at 1 kHz using a module with a maximum rate of 10 Hz, the
slow module returns 100 samples of the first point, followed by 100 samples of the second point,
etc. Other modules in the task will return 1,000 new data points per second, which is normal.
When performing a single-point acquisition, no points are repeated. To avoid this behavior, use
multiple AI timing engines, and assign slow sample rate modules to a task with a rate at or slower
than their maximum rate.
For more information about which C Series modules are compatible with the cDAQ chassis, go
to ni.com/info and enter the Info Code rdcdaq.
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AI Start Trigger Signal
Use the Start Trigger signal to begin a measurement acquisition. A measurement acquisition
consists of one or more samples. If you do not use triggers, begin a measurement with a software
command. Once the acquisition begins, configure the acquisition to stop in one of the following
ways:
•

When a certain number of points has been sampled (in finite mode)

•

After a hardware reference trigger (in finite mode)

•

With a software command (in continuous mode)

An acquisition that uses a start trigger (but not a reference trigger) is sometimes referred to as a
posttriggered acquisition. That is, samples are measured only after the trigger.
When you are using an internal sample clock, you can specify a default delay from the start
trigger to the first sample.

Using a Digital Source
To use the Start Trigger signal with a digital source, specify a source and a rising or falling edge.
Use the following signals as the source:
•

Any PFI terminal

•

Counter n Internal Output

The source also can be one of several other internal signals on your cDAQ chassis. Refer to the
Device Routing in MAX topic in the NI-DAQmx Help or the LabVIEW Help for more
information.

Using an Analog Source
Some C Series modules can generate a trigger based on an analog signal. In NI-DAQmx, this is
called the Analog Comparison Event. When you use an analog trigger source for Start Trigger,
the acquisition begins on the first rising edge of the Analog Comparison Event signal.
Note Depending on the C Series module capabilities, you may need two modules
to utilize analog triggering.

Using a Time Source
To use the Start Trigger signal with a time source, specify a specific time in NI-DAQmx. Refer
to the Timestamps and Time Triggering topics in the NI-DAQmx Help for more information on
accessing time-based features in the NI-DAQmx API.

Routing AI Start Trigger to an Output Terminal
You can route the Start Trigger signal to any output PFI terminal. The output is an active high
pulse.
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AI Reference Trigger Signal
Use Reference Trigger to stop a measurement acquisition. To use a reference trigger, specify a
buffer of finite size and a number of pretrigger samples (samples that occur before the reference
trigger). The number of posttrigger samples (samples that occur after the reference trigger)
desired is the buffer size minus the number of pretrigger samples.
Once the acquisition begins, the cDAQ chassis writes samples to the buffer. After the cDAQ
chassis captures the specified number of pretrigger samples, the cDAQ chassis begins to look
for the reference trigger condition. If the reference trigger condition occurs before the cDAQ
chassis captures the specified number of pretrigger samples, the chassis ignores the condition.
If the buffer becomes full, the cDAQ chassis continuously discards the oldest samples in the
buffer to make space for the next sample. This data can be accessed (with some limitations)
before the cDAQ chassis discards it. Refer to the Can a Pretriggered Acquisition be
Continuous? document for more information. To access this document, go to ni.com/info
and enter the Info Code rdcanq.
When the reference trigger occurs, the cDAQ chassis continues to write samples to the buffer
until the buffer contains the number of posttrigger samples desired. Figure 3-3 shows the final
buffer.
Figure 3-3. Reference Trigger Final Buffer
Reference Trigger
Pretrigger Samples

Posttrigger Samples

Complete Buffer

Using a Digital Source
To use Reference Trigger with a digital source, specify a source and a rising or falling edge.
Either PFI or one of several internal signals on the cDAQ chassis can provide the source. Refer
to the Device Routing in MAX topic in the NI-DAQmx Help or the LabVIEW Help for more
information.
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Using an Analog Source
Some C Series modules can generate a trigger based on an analog signal. In NI-DAQmx, this is
called the Analog Comparison Event.
When you use an analog trigger source, the acquisition stops on the first rising or falling edge of
the Analog Comparison Event signal, depending on the trigger properties.
Note Depending on the C Series module capabilities, you may need two modules
to utilize analog triggering.

Routing the Reference Trigger Signal to an Output Terminal
You can route Reference Trigger to any output PFI terminal. Reference Trigger is active high by
default.

AI Pause Trigger Signal
You can use the Pause Trigger to pause and resume a measurement acquisition. The internal
sample clock pauses while the external trigger signal is active and resumes when the signal is
inactive. You can program the active level of the pause trigger to be high or low.

Using a Digital Source
To use the Pause Trigger, specify a source and a polarity. The source can be either from PFI or
one of several other internal signals on your cDAQ chassis. Refer to the Device Routing in MAX
topic in the NI-DAQmx Help or the LabVIEW Help for more information.

Using an Analog Source
Some C Series modules can generate a trigger based on an analog signal. In NI-DAQmx, this is
called the Analog Comparison Event.
When you use an analog trigger source, the internal sample clock pauses when the Analog
Comparison Event signal is low and resumes when the signal goes high (or vice versa).
Note Depending on the C Series module capabilities, you may need two modules
to utilize analog triggering.
Note

Pause triggers are only sensitive to the level of the source, not the edge.
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Analog Input Sync Pulse
You can use time as a trigger for sync pulses on delta-sigma C Series modules. To use a sync
pulse with a time source, specify a specific time in NI-DAQmx. Refer to the Time Triggering
topic in the NI-DAQmx Help for more information on accessing time-based features in the
NI-DAQmx API.
Note To accurately synchronize delta-sigma devices in two or more separate tasks,
you must specify the same sync pulse. Otherwise, a sync pulse is initiated by software
implicitly, even if time start triggers are specified for the tasks. However, for
multichassis tasks, the sync pulses and start triggers are automatically synchronized.

Getting Started with AI Applications in Software
You can use the cDAQ chassis in the following analog input applications:
•

Single-point acquisition

•

Finite acquisition

•

Continuous acquisition

For more information about programming analog input applications and triggers in software,
refer to the NI-DAQmx Help or the LabVIEW Help for more information.
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To generate analog output, install an analog output C Series module in any slot on the cDAQ
chassis. The generation specifications, such as the number of channels, channel configuration,
update rate, and output range, are determined by the type of C Series module used. For more
information, refer to the documentation included with your C Series module(s).
On a single analog output C Series module, you can assign any number of channels to either a
hardware-timed task or a software-timed (single-point) task. However, you cannot assign some
channels to a hardware-timed task and other channels (on the same module) to a software-timed
task.
Any hardware-timed task or software-timed task can have channels from multiple modules in
the same chassis.

Analog Output Data Generation Methods
When performing an analog output operation, you either can perform software-timed or
hardware-timed generations. Hardware-timed generations must be buffered.

Software-Timed Generations
With a software-timed generation, software controls the rate at which data is generated. Software
sends a separate command to the hardware to initiate each DAC conversion. In NI-DAQmx,
software-timed generations are referred to as on-demand timing. Software-timed generations are
also referred to as immediate or static operations. They are typically used for writing out a single
value, such as a constant DC voltage.
The following considerations apply to software-timed generations:
•
If any AO channel on a module is used in a hardware-timed (waveform) task, no channels
on that module can be used in a software-timed task
•
You can configure software-timed generations to simultaneously update
•
Only one simultaneous update task can run at a time
•

A hardware-timed AO task and a simultaneous update AO task cannot run at the same time
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Hardware-Timed Generations
With a hardware-timed generation, a digital hardware signal controls the rate of the generation.
This signal can be generated internally on the chassis or provided externally.
Hardware-timed generations have several advantages over software-timed acquisitions:
•

The time between samples can be much shorter

•

The timing between samples is deterministic

•

Hardware-timed acquisitions can use hardware triggering

Hardware-timed AO operations on the cDAQ chassis must be buffered.

Buffered Analog Output
A buffer is a temporary storage in computer memory for generated samples. In a buffered
generation, data is moved from a host buffer to the cDAQ chassis onboard FIFO before it is
written to the C Series modules.
One property of buffered I/O operations is sample mode. The sample mode can be either finite
or continuous:
•

Finite—Finite sample mode generation refers to the generation of a specific,
predetermined number of data samples. After the specified number of samples is written
out, the generation stops.

•

Continuous—Continuous generation refers to the generation of an unspecified number of
samples. Instead of generating a set number of data samples and stopping, a continuous
generation continues until you stop the operation. There are three different continuous
generation modes that control how the data is written. These modes are regeneration,
onboard regeneration, and non-regeneration:

4-2

–

In regeneration mode, you define a buffer in host memory. The data from the buffer is
continually downloaded to the FIFO to be written out. New data can be written to the
host buffer at any time without disrupting the output. There is no limitation on the
number of waveform channels supported by regeneration mode.

–

With onboard regeneration, the entire buffer is downloaded to the FIFO and
regenerated from there. After the data is downloaded, new data cannot be written to
the FIFO. To use onboard regeneration, the entire buffer must fit within the FIFO size.
The advantage of using onboard regeneration is that it does not require communication
with the main host memory once the operation is started, which prevents problems that
may occur due to excessive bus traffic or operating system latency. There is a limit of
16 waveform channels for onboard regeneration.

–

With non-regeneration, old data is not repeated. New data must continually be written
to the buffer. If the program does not write new data to the buffer at a fast enough rate
to keep up with the generation, the buffer underflows and causes an error. There is no
limitation on the number of waveform channels supported by non-regeneration.
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Analog Output Triggering Signals
A trigger is a signal that causes an action, such as starting or stopping the acquisition of data.
When you configure a trigger, you must decide how you want to produce the trigger and the
action you want the trigger to cause. The cDAQ chassis supports internal software triggering,
external digital triggering, analog triggering, and internal time triggering.
Analog output supports two different triggering actions: AO Start Trigger and AO Pause Trigger.
An analog or digital signal can initiate these actions. Time can also initiate the Start Trigger. Up
to two C Series parallel digital input modules can be used in any chassis slot to supply a digital
trigger. An analog trigger can be supplied by some C Series analog modules.
Refer to the AO Start Trigger Signal and AO Pause Trigger Signal sections for more information
about the analog output trigger signals.

Analog Output Timing Signals
The cDAQ chassis features the following AO (waveform generation) timing signals:
•

AO Sample Clock Signal*

•

AO Sample Clock Timebase Signal

•

AO Start Trigger Signal*

•

AO Pause Trigger Signal*

Signals with an * support digital filtering. Refer to the PFI Filters section of Chapter 5, Digital
Input/Output and PFI, for more information.
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AO Sample Clock Signal
The AO sample clock (ao/SampleClock) signals when all the analog output channels in the task
update. AO Sample Clock can be generated from external or internal sources as shown in
Figure 4-1.
Figure 4-1. Analog Output Timing Options

PFI
Analog Comparison Event
PFI
Analog Comparison
Event
80 MHz Timebase

Ctr n Internal Output
AO Sample Clock
Timebase

AO Sample
Clock

Programmable
Clock
Divider

20 MHz Timebase
13.1072 MHz Timebase
12.8 MHz Timebase
10 MHz Timebase
100 kHz Timebase

Routing AO Sample Clock to an Output Terminal
You can route AO Sample Clock to any output PFI terminal. AO Sample Clock is active high
by default.

AO Sample Clock Timebase Signal
The AO Sample Clock Timebase (ao/SampleClockTimebase) signal is divided down to provide
a source for AO Sample Clock. AO Sample Clock Timebase can be generated from external or
internal sources, and is not available as an output from the chassis.

Delta-Sigma Modules
The oversample clock is used as the AO Sample Clock Timebase. The cDAQ chassis supplies
10 MHz, 12.8 MHz, and 13.1072 MHz timebases. When delta-sigma modules with different
oversample clock frequencies are used in an analog output task, the AO Sample Clock Timebase
can use any of the available frequencies; by default, the fastest available is used. The update rate
of all modules in the task is an integer divisor of the frequency of the AO Sample Clock
Timebase.
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AO Start Trigger Signal
Use the AO Start Trigger (ao/StartTrigger) signal to initiate a waveform generation. If you do
not use triggers, you can begin a generation with a software command. If you are using an
internal sample clock, you can specify a delay from the start trigger to the first sample. For more
information, refer to the NI-DAQmx Help.

Using a Digital Source
To use AO Start Trigger, specify a source and a rising or falling edge. The source can be one of
the following signals:
•
A pulse initiated by host software
•
Any PFI terminal
•
AI Reference Trigger
•
AI Start Trigger
The source also can be one of several internal signals on the cDAQ chassis. Refer to the Device
Routing in MAX topic in the NI-DAQmx Help or the LabVIEW Help for more information.
You also can specify whether the waveform generation begins on the rising edge or falling edge
of AO Start Trigger.

Using an Analog Source
Some C Series modules can generate a trigger based on an analog signal. In NI-DAQmx, this is
called the Analog Comparison Event, depending on the trigger properties.
When you use an analog trigger source, the waveform generation begins on the first rising or
falling edge of the Analog Comparison Event signal, depending on the trigger properties. The
analog trigger circuit must be configured by a simultaneously running analog input task.
Note Depending on the C Series module capabilities, you may need two modules
to utilize analog triggering.

Using a Time Source
To use AO Start Trigger signal with a time source, specify a specific time in NI-DAQmx. Refer
to the Timestamps and Time Triggering topics in the NI-DAQmx Help for more information on
accessing time-based features in the NI-DAQmx API.

Routing AO Start Trigger Signal to an Output Terminal
You can route AO Start Trigger to any output PFI terminal. The output is an active high pulse.
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AO Pause Trigger Signal
Use the AO Pause Trigger signal (ao/PauseTrigger) to mask off samples in a DAQ sequence.
When AO Pause Trigger is active, no samples occur, but AO Pause Trigger does not stop a
sample that is in progress. The pause does not take effect until the beginning of the next sample.
When you generate analog output signals, the generation pauses as soon as the pause trigger is
asserted. If the source of the sample clock is the onboard clock, the generation resumes as soon
as the pause trigger is deasserted, as shown in Figure 4-2.
Figure 4-2. AO Pause Trigger with the Onboard Clock Source

Pause Trigger

Sample Clock

If you are using any signal other than the onboard clock as the source of the sample clock, the
generation resumes as soon as the pause trigger is deasserted and another edge of the sample
clock is received, as shown in Figure 4-3.
Figure 4-3. AO Pause Trigger with Other Signal Source

Pause Trigger

Sample Clock

Using a Digital Source
To use AO Pause Trigger, specify a source and a polarity. The source can be a PFI signal or one
of several other internal signals on the cDAQ chassis.
You also can specify whether the samples are paused when AO Pause Trigger is at a logic high
or low level. Refer to the Device Routing in MAX topic in the NI-DAQmx Help or the
LabVIEW Help for more information.
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Using an Analog Source
Some C Series modules can generate a trigger based on an analog signal. In NI-DAQmx, this is
called the Analog Comparison Event, depending on the trigger properties.
When you use an analog trigger source, the samples are paused when the Analog Comparison
Event signal is at a high or low level, depending on the trigger properties. The analog trigger
circuit must be configured by a simultaneously running analog input task.
Note Depending on the C Series module capabilities, you may need two modules
to utilize analog triggering.

Analog Output Sync Pulse
You can use time as a trigger for sync pulses on delta-sigma C Series modules. To use a sync
pulse with a time source, specify a specific time in NI-DAQmx. Refer to the Time Triggering
topic in the NI-DAQmx Help for more information on accessing time-based features in the
NI-DAQmx API.
Note To accurately synchronize delta-sigma devices in two or more separate tasks,
you must specify the same sync pulse. Otherwise, a sync pulse is initiated by software
implicitly, even if time start triggers are specified for the tasks. However, for
multichassis tasks, the sync pulses and start triggers are automatically synchronized.

Minimizing Glitches on the Output Signal
When you use a DAC to generate a waveform, you may observe glitches on the output signal.
These glitches are normal; when a DAC switches from one voltage to another, it produces
glitches due to released charges. The largest glitches occur when the most significant bit of the
DAC code changes. You can build a lowpass deglitching filter to remove some of these glitches,
depending on the frequency and nature of the output signal. Go to ni.com/support for more
information about minimizing glitches.
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Using the Watchdog Timer
You can use the watchdog timer for analog output operations. Refer to the Watchdog Timer
section of Chapter 1, Getting Started with the cDAQ Chassis, for more information.

Getting Started with AO Applications in Software
You can use the cDAQ chassis in the following analog output applications:
•

Single-point (on-demand) generation

•

Finite generation

•

Continuous generation

•

Waveform generation

For more information about programming analog output applications and triggers in software,
refer the LabVIEW Help or to the NI-DAQmx Help.
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5

This chapter describes the digital input/output (DIO) and Programmable Function Interface
(PFI) functionality available on the cDAQ chassis. Refer to the Digital Input/Output and PFI
sections.

Digital Input/Output
To use digital I/O, install a digital C Series module into any slot on the cDAQ chassis. The I/O
specifications, such as number of lines, logic levels, update rate, and line direction, are
determined by the type of C Series module used. For more information, refer to the
documentation included with your C Series module(s).

Serial DIO versus Parallel DIO Modules
Serial digital modules have more than eight lines of digital input/output. They can be used in any
chassis slot and can perform the following tasks:
•

Software-timed and hardware-timed digital input/output tasks

Parallel digital modules can be used in any chassis slot and can perform the following tasks:
•

Software-timed and hardware-timed digital input/output tasks

•

Counter/timer tasks (can be used in up to two slots)

•

Accessing PFI signal tasks (can be used in up to two slots)

•

Filter digital input signals

Software-timed and hardware-timed digital input/output tasks have the following restrictions:
•

You cannot use parallel and serial modules together on the same hardware-timed task.

•

You cannot use serial modules for triggering.

•

You cannot do both static and timed tasks at the same time on a single serial module.

•

You can only do hardware timing in one direction at a time on a serial bidirectional module.

To determine the capability of digital modules supported by the cDAQ controller, refer to the
C Series Support in NI-DAQmx document by going to ni.com/info and entering the Info
Code rdcdaq.
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Static DIO
Each of the DIO lines can be used as a static DI or DO line. You can use static DIO lines to
monitor or control digital signals on some C Series modules. Each DIO line can be individually
configured as a digital input (DI) or digital output (DO), if the C Series module being used allows
such configuration.
All samples of static DI lines and updates of static DO lines are software-timed.

Digital Input
You can acquire digital waveforms using either parallel or serial digital modules.
The DI waveform acquisition FIFO stores the digital samples. The cDAQ chassis samples the
DIO lines on each rising or falling edge of the DI Sample Clock signal.

Digital Input Triggering Signals
A trigger is a signal that causes an action, such as starting or stopping the acquisition of data.
When you configure a trigger, you must decide how you want to produce the trigger and the
action you want the trigger to cause. The cDAQ chassis supports internal software triggering,
external digital triggering, analog triggering, and internal time triggering.
Three triggers are available: Start Trigger, Reference Trigger, and Pause Trigger. An analog or
digital trigger can initiate these three trigger actions. Time can also initiate the Start Trigger. Up to
two C Series parallel digital input modules can be used in any chassis slot to supply a digital
trigger. To find your module triggering options, refer to the documentation included with your
C Series modules. For more information about using analog modules for triggering, refer to the
Analog Input Triggering Signals section of Chapter 3, Analog Input, and the Analog Output
Triggering Signals section of Chapter 4, Analog Output.
Refer to the DI Start Trigger Signal, DI Reference Trigger Signal, and DI Pause Trigger Signal
sections for more information about the digital input trigger signals.

Digital Input Timing Signals
The cDAQ chassis features the following digital input timing signals:
•

DI Sample Clock Signal*

•

DI Sample Clock Timebase Signal

•

DI Start Trigger Signal*

•

DI Reference Trigger Signal*

•

DI Pause Trigger Signal*

Signals with an * support digital filtering. Refer to the PFI Filters section for more information.
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DI Sample Clock Signal
Use the DI Sample Clock (di/SampleClock) signal to sample digital I/O on any slot using
parallel digital modules, and store the result in the DI waveform acquisition FIFO. If the cDAQ
chassis receives a DI Sample Clock signal when the FIFO is full, it reports an overflow error to
the host software.
A sample consists of one reading from each channel in the DI task. DI Sample Clock signals the
start of a sample of all digital input channels in the task. DI Sample Clock can be generated from
external or internal sources as shown in Figure 5-1.
Figure 5-1. DI Sample Clock Timing Options
PFI
Analog Comparison Event
Ctr n Internal Output
PFI
Analog Comparison
Event

DI Sample
Clock

Sigma-Delta Module Internal Output
DI Sample Clock
Timebase

80 MHz Timebase

Programmable
Clock
Divider

20 MHz Timebase
13.1072 MHz Timebase
12.8 MHz Timebase
10 MHz Timebase
100 kHz Timebase

Routing DI Sample Clock to an Output Terminal
You can route DI Sample Clock to any output PFI terminal.

DI Sample Clock Timebase Signal
The DI Sample Clock Timebase (di/SampleClockTimebase) signal is divided down to provide
a source for DI Sample Clock. DI Sample Clock Timebase can be generated from external or
internal sources. DI Sample Clock Timebase is not available as an output from the chassis.

Using an Internal Source
To use DI Sample Clock with an internal source, specify the signal source and the polarity of the
signal. Use the following signals as the source:
•

AI Sample Clock

•

AO Sample Clock

•

Counter n Internal Output

•

Frequency Output

•

DI Change Detection Output

© National Instruments

|

5-3

Chapter 5

Digital Input/Output and PFI

Several other internal signals can be routed to DI Sample Clock. Refer to the Device Routing in
MAX topic in the NI-DAQmx Help or the LabVIEW Help for more information.

Using an External Source
You can route the following signals as DI Sample Clock:
•

Any PFI terminal

•

Analog Comparison Event (an analog trigger)

You can sample data on the rising or falling edge of DI Sample Clock.

Routing DI Sample Clock to an Output Terminal
You can route DI Sample Clock to any output PFI terminal. The PFI circuitry inverts the polarity
of DI Sample Clock before driving the PFI terminal.

DI Start Trigger Signal
Use the DI Start Trigger (di/StartTrigger) signal to begin a measurement acquisition. A
measurement acquisition consists of one or more samples. If you do not use triggers, begin a
measurement with a software command. Once the acquisition begins, configure the acquisition
to stop in one of the following ways:
•

When a certain number of points has been sampled (in finite mode)

•

After a hardware reference trigger (in finite mode)

•

With a software command (in continuous mode)

An acquisition that uses a start trigger (but not a reference trigger) is sometimes referred to as a
posttriggered acquisition. That is, samples are measured only after the trigger.
When you are using an internal sample clock, you can specify a delay from the start trigger to
the first sample.

Using a Digital Source
To use DI Start Trigger with a digital source, specify a source and a rising or falling edge. Use
the following signals as the source:
•

Any PFI terminal

•

Counter n Internal Output

The source also can be one of several other internal signals on the cDAQ chassis. Refer to the
Device Routing in MAX topic in the NI-DAQmx Help or the LabVIEW Help for more
information.

Using an Analog Source
Some C Series modules can generate a trigger based on an analog signal. In NI-DAQmx, this is
called the Analog Comparison Event. When you use an analog trigger source for DI Start
Trigger, the acquisition begins on the first rising edge of the Analog Comparison Event signal.
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Note Depending on the C Series module capabilities, you may need two modules
to utilize analog triggering.

Using a Time Source
To use the Start Trigger signal with a time source, specify a specific time in NI-DAQmx. Refer
to the Timestamps and Time Triggering topics in the NI-DAQmx Help for more information on
accessing time-based features in the NI-DAQmx API.

Routing DI Start Trigger to an Output Terminal
You can route DI Start Trigger to any output PFI terminal. The output is an active high pulse.

DI Reference Trigger Signal
Use a reference trigger (di/ReferenceTrigger) signal to stop a measurement acquisition. To use
a reference trigger, specify a buffer of finite size and a number of pretrigger samples (samples
that occur before the reference trigger). The number of posttrigger samples (samples that occur
after the reference trigger) desired is the buffer size minus the number of pretrigger samples.
Once the acquisition begins, the cDAQ chassis writes samples to the buffer. After the cDAQ
chassis captures the specified number of pretrigger samples, the chassis begins to look for the
reference trigger condition. If the reference trigger condition occurs before the cDAQ chassis
captures the specified number of pretrigger samples, the chassis ignores the condition.
If the buffer becomes full, the cDAQ chassis continuously discards the oldest samples in the
buffer to make space for the next sample. This data can be accessed (with some limitations)
before the cDAQ chassis discards it. Refer to the Can a Pretriggered Acquisition be
Continuous? document for more information. To access this document, go to ni.com/info
and enter the Info Code rdcanq.
When the reference trigger occurs, the cDAQ chassis continues to write samples to the buffer
until the buffer contains the number of posttrigger samples desired. Figure 5-2 shows the final
buffer.
Figure 5-2. Reference Trigger Final Buffer
Reference Trigger
Pretrigger Samples

Posttrigger Samples

Complete Buffer
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Using a Digital Source
To use DI Reference Trigger with a digital source, specify a source and a rising or falling edge.
Either PFI or one of several internal signals on the cDAQ chassis can provide the source. Refer
to the Device Routing in MAX topic in the NI-DAQmx Help or the LabVIEW Help for more
information.

Using an Analog Source
Some C Series modules can generate a trigger based on an analog signal. In NI-DAQmx, this is
called the Analog Comparison Event.
When you use an analog trigger source, the acquisition stops on the first rising or falling edge of
the Analog Comparison Event signal, depending on the trigger properties.
Depending on the C Series module capabilities, you may need two modules
to utilize analog triggering.
Note

Routing DI Reference Trigger Signal to an Output Terminal
You can route DI Reference Trigger to any output PFI terminal. Reference Trigger is active high
by default.

DI Pause Trigger Signal
You can use the DI Pause Trigger (di/PauseTrigger) signal to pause and resume a measurement
acquisition. The internal sample clock pauses while the external trigger signal is active and
resumes when the signal is inactive. You can program the active level of the pause trigger to be
high or low.

Using a Digital Source
To use DI Pause Trigger, specify a source and a polarity. The source can be either from PFI or
one of several other internal signals on your cDAQ chassis. Refer to the Device Routing in MAX
topic in the NI-DAQmx Help or the LabVIEW Help for more information.

Using an Analog Source
Some C Series modules can generate a trigger based on an analog signal. In NI-DAQmx, this is
called the Analog Comparison Event.
When you use an analog trigger source, the internal sample clock pauses when the Analog
Comparison Event signal is low and resumes when the signal goes high (or vice versa).
Depending on the C Series module capabilities, you may need two modules
to utilize analog triggering.
Note

Note
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Digital Input Filters
When performing a hardware timed task, you can enable a programmable debouncing filter on the
digital input lines of a parallel DIO module. All lines on a module must share the same filter
configuration. When the filter is enabled, the chassis samples the inputs with a user-configured
Filter Clock derived from the chassis timebase. This is used to determine whether a pulse is
propagated to the rest of the system. However, the filter also introduces jitter onto the input signal.
In NI-DAQmx, the filter is programmed by setting the minimum pulse width, Tp1, that will pass
the filter, and is selectable in 25 ns increments. The appropriate Filter Clock is selected by the
driver. Pulses of length less than 1/2 Tp will be rejected, and the filtering behavior of lengths
between 1/2 Tp and 1 Tp are not defined because they depend on the phase of the Filter Clock
relative to the input signal.
Figure 5-3 shows an example of low-to-high transitions of the input signal. High-to-low
transitions work similarly.
Assume that an input terminal has been low for a long time. The input terminal then changes
from low to high, but glitches several times. When the filter clock has sampled the signal high
on consecutive rising edges, the low-to-high transition is propagated to the rest of the circuit.
Figure 5-3. Filter Example
Digital Input P0.x
1

1

1

1

2

1

2

Filter Clock
Filtered Input

Getting Started with DI Applications in Software
You can use the cDAQ chassis in the following digital input applications:
•

Single-point acquisition

•

Finite acquisition

•

Continuous acquisition

For more information about programming digital input applications and triggers in software,
refer to the NI-DAQmx Help or the LabVIEW Help for more information.

1

Tp is a nominal value; the accuracy of the chassis timebase and I/O distortion will affect this value.
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Change Detection Event
The Change Detection Event is the signal generated when a change on the rising or falling edge
lines is detected by the change detection task.

Routing Change Detection Event to an Output Terminal
You can route ChangeDetectionEvent to any output PFI terminal.

Change Detection Acquisition
You can configure lines on parallel digital modules to detect rising or falling edges. When one
or more of these lines sees the edge specified for that line, the cDAQ chassis samples all the lines
in the task. The rising and falling edge lines do not necessarily have to be in the task.
Change detection acquisitions can be buffered or nonbuffered:
•

Nonbuffered Change Detection Acquisition—In a nonbuffered acquisition, data is
transferred from the cDAQ chassis directly to a PC buffer.

•

Buffered Change Detection Acquisition—A buffer is a temporary storage in computer
memory for acquired samples. In a buffered acquisition, data is stored in the cDAQ chassis
onboard FIFO then transferred to a PC buffer. Buffered acquisitions typically allow for
much faster transfer rates than nonbuffered acquisitions because data accumulates and is
transferred in blocks, rather than one sample at a time.

Digital Output
To generate digital output, install a digital output C Series module in any slot on the cDAQ
chassis. The generation specifications, such as the number of channels, channel configuration,
update rate, and output range, are determined by the type of C Series module used. For more
information, refer to the documentation included with your C Series module(s).
With parallel digital output modules (formerly known as hardware-timed modules), you can
do multiple software-timed tasks on a single module, as well as mix hardware-timed and
software-timed digital output tasks on a single module. On serial digital output modules
(formerly known as static digital output modules), you cannot mix hardware-timed and
software-timed tasks, but you can run multiple software-timed tasks.
You may have a hardware-timed task or a software-timed task include channels from multiple
modules, but a hardware-timed task may not include a mix of channels from both parallel and
serial modules.
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Digital Output Data Generation Methods
When performing a digital output operation, you either can perform software-timed or
hardware-timed generations. Hardware-timed generations must be buffered.

Software-Timed Generations
With a software-timed generation, software controls the rate at which data is generated. Software
sends a separate command to the hardware to initiate each digital generation. In NI-DAQmx,
software-timed generations are referred to as on-demand timing. Software-timed generations are
also referred to as immediate or static operations. They are typically used for writing out a single
value.
For software-timed generations, if any DO channel on a serial digital module is used in a
hardware-timed task, no channels on that module can be used in a software-timed task.

Hardware-Timed Generations
With a hardware-timed generation, a digital hardware signal controls the rate of the generation.
This signal can be generated internally on the chassis or provided externally.
Hardware-timed generations have several advantages over software-timed acquisitions:
•

The time between samples can be much shorter.

•

The timing between samples is deterministic.

•

Hardware-timed acquisitions can use hardware triggering.

Hardware-timed DO operations on the cDAQ chassis must be buffered.

Buffered Digital Output
A buffer is a temporary storage in computer memory for generated samples. In a buffered
generation, data is moved from a host buffer to the cDAQ chassis onboard FIFO before it is
written to the C Series module(s).
One property of buffered I/O operations is sample mode. The sample mode can be either finite
or continuous:
•

Finite—Finite sample mode generation refers to the generation of a specific,
predetermined number of data samples. After the specified number of samples is written
out, the generation stops.

•

Continuous—Continuous generation refers to the generation of an unspecified number of
samples. Instead of generating a set number of data samples and stopping, a continuous
generation continues until you stop the operation. There are three different continuous
generation modes that control how the data is written. These modes are regeneration,
onboard regeneration, and non-regeneration:
–

In regeneration mode, you define a buffer in host memory. The data from the buffer is
continually downloaded to the FIFO to be written out. New data can be written to the
host buffer at any time without disrupting the output.
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With onboard regeneration, the entire buffer is downloaded to the FIFO and
regenerated from there. After the data is downloaded, new data cannot be written to
the FIFO. To use onboard regeneration, the entire buffer must fit within the FIFO size.
The advantage of using onboard regeneration is that it does not require communication
with the main host memory once the operation is started, which prevents problems that
may occur due to excessive bus traffic or operating system latency.
Install parallel DO modules in slots 1 through 4 to maximize accessible FIFO
size because using a module in slots 5 through 8 will reduce the accessible FIFO size.

Note

–

With non-regeneration, old data is not repeated. New data must continually be written
to the buffer. If the program does not write new data to the buffer at a fast enough rate
to keep up with the generation, the buffer underflows and causes an error.

Digital Output Triggering Signals
A trigger is a signal that causes an action, such as starting or stopping the acquisition of data.
When you configure a trigger, you must decide how you want to produce the trigger and the
action you want the trigger to cause. The cDAQ chassis supports internal software triggering,
external digital triggering, analog triggering, and internal time triggering.
Digital output supports two different triggering actions: DO Start Trigger and DO Pause Trigger.
A digital or analog trigger can initiate these actions. Time can also initiate the Start Trigger. Any
PFI terminal can supply a digital trigger, and some C Series analog modules can supply an
analog trigger. For more information, refer to the documentation included with your C Series
module(s).
Refer to the DO Start Trigger Signal and DO Pause Trigger Signal sections for more
information about the digital output trigger signals.

Digital Output Timing Signals
The cDAQ chassis features the following DO timing signals:
•

DO Sample Clock Signal*

•

DO Sample Clock Timebase Signal

•

DO Start Trigger Signal*

•

DO Pause Trigger Signal*

Signals with an * support digital filtering. Refer to the PFI Filters section for more information.
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DO Sample Clock Signal
The DO Sample Clock (do/SampleClock) signals when all the digital output channels in the task
update. DO Sample Clock can be generated from external or internal sources as shown in
Figure 5-4.
Figure 5-4. Digital Output Timing Options
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Routing DO Sample Clock to an Output Terminal
You can route DO Sample Clock to any output PFI terminal. DO Sample Clock is active high
by default.

DO Sample Clock Timebase Signal
The DO Sample Clock Timebase (do/SampleClockTimebase) signal is divided down to provide
a source for DO Sample Clock. DO Sample Clock Timebase can be generated from external or
internal sources, and is not available as an output from the chassis.

DO Start Trigger Signal
Use the DO Start Trigger (do/StartTrigger) signal to initiate a waveform generation. If you do
not use triggers, you can begin a generation with a software command. If you are using an
internal sample clock, you can specify a delay from the start trigger to the first sample. For more
information, refer to the NI-DAQmx Help.

© National Instruments

|

5-11

Chapter 5

Digital Input/Output and PFI

Using a Digital Source
To use DO Start Trigger, specify a source and a rising or falling edge. The source can be one of
the following signals:
•

A pulse initiated by host software

•

Any PFI terminal

•

AI Reference Trigger

•

AI Start Trigger

The source also can be one of several internal signals on the cDAQ chassis. Refer to the Device
Routing in MAX topic in the NI-DAQmx Help or the LabVIEW Help for more information.
You also can specify whether the waveform generation begins on the rising edge or falling edge
of DO Start Trigger.

Using an Analog Source
Some C Series modules can generate a trigger based on an analog signal. In NI-DAQmx, this is
called the Analog Comparison Event, depending on the trigger properties.
When you use an analog trigger source, the waveform generation begins on the first rising or
falling edge of the Analog Comparison Event signal, depending on the trigger properties. The
analog trigger circuit must be configured by a simultaneously running analog input task.
Depending on the C Series module capabilities, you may need two modules
to utilize analog triggering.
Note

Using a Time Source
To use the Start Trigger signal with a time source, specify a specific time in NI-DAQmx. Refer
to the Timestamps and Time Triggering topics in the NI-DAQmx Help for more information on
accessing time-based features in the NI-DAQmx API.

Routing DO Start Trigger Signal to an Output Terminal
You can route DO Start Trigger to any output PFI terminal. The output is an active high pulse.

DO Pause Trigger Signal
Use the DO Pause Trigger signal (do/PauseTrigger) to mask off samples in a DAQ sequence.
When DO Pause Trigger is active, no samples occur, but DO Pause Trigger does not stop a
sample that is in progress. The pause does not take effect until the beginning of the next sample.
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When you generate digital output signals, the generation pauses as soon as the pause trigger is
asserted. If the source of the sample clock is the onboard clock, the generation resumes as soon
as the pause trigger is deasserted, as shown in Figure 5-5.
Figure 5-5. DO Pause Trigger with the Onboard Clock Source

Pause Trigger

Sample Clock

If you are using any signal other than the onboard clock as the source of the sample clock, the
generation resumes as soon as the pause trigger is deasserted and another edge of the sample
clock is received, as shown in Figure 5-6.
Figure 5-6. DO Pause Trigger with Other Signal Source

Pause Trigger

Sample Clock

Using a Digital Source
To use DO Pause Trigger, specify a source and a polarity. The source can be a PFI signal or one
of several other internal signals on the cDAQ chassis.
You also can specify whether the samples are paused when DO Pause Trigger is at a logic
high or low level. Refer to the Device Routing in MAX topic in the NI-DAQmx Help or the
LabVIEW Help for more information.

Using an Analog Source
Some C Series modules can generate a trigger based on an analog signal. In NI-DAQmx, this is
called the Analog Comparison Event, depending on the trigger properties.
When you use an analog trigger source, the samples are paused when the Analog Comparison
Event signal is at a high or low level, depending on the trigger properties. The analog trigger
circuit must be configured by a simultaneously running analog input task.
Note Depending on the C Series module capabilities, you may need two modules
to utilize analog triggering.
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Using the Watchdog Timer
You can use the watchdog timer for digital output operations. Refer to the Watchdog Timer
section of Chapter 1, Getting Started with the cDAQ Chassis, for more information.

Getting Started with DO Applications in Software
You can use the cDAQ chassis in the following digital output applications:
•

Single-point (on-demand) generation

•

Finite generation

•

Continuous generation

For more information about programming digital output applications and triggers in software,
refer the LabVIEW Help or to the NI-DAQmx Help.

Digital Input/Output Configuration for NI 9401
When you change the configuration of lines on a NI 9401 digital module between input and
output, NI-DAQmx temporarily reserves all of the lines on the module for communication to
send the module a line configuration command. For this reason, you must reserve the task in
advance through the DAQmx Control Task before any task has started. If another task or route
is actively using the module, to avoid interfering with the other task, NI-DAQmx generates an
error instead of sending the line configuration command. During the line configuration
command, the output lines are maintained without glitching.

PFI
You can configure channels of a parallel digital module as Programmable Function Interface
(PFI) terminals. The cDAQ chassis also provides one terminal for PFI. Up to two digital modules
can be used to access PFI terminals in a single chassis.
You can configure each PFI individually as the following:
•

Timing input signal for AI, AO, DI, DO, or counter/timer functions

•

Timing output signal from AI, AO, DI, DO, or counter/timer functions

PFI Filters
You can enable a programmable debouncing filter on each PFI signal. When the filter is enabled,
the chassis samples the inputs with a user-configured Filter Clock derived from the chassis
timebase. This is used to determine whether a pulse is propagated to the rest of the circuit.
However, the filter also introduces jitter onto the PFI signal.
The following is an example of low-to-high transitions of the input signal. High-to-low
transitions work similarly.
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Assume that an input terminal has been low for a long time. The input terminal then changes
from low to high, but glitches several times. When the Filter Clock has sampled the signal high
on N consecutive edges, the low-to-high transition is propagated to the rest of the circuit. The
value of N depends on the filter setting, as shown in Table 5-1.
Table 5-1. Selectable PFI Filter Settings
Max Pulse
Width*
to Not Pass

Filter Clock

Jitter

Min Pulse
Width* to Pass

112.5 ns
(short)

80 MHz

12.5 ns

112.5 ns

100 ns

6.4 μs
(medium)

80 MHz

12.5 ns

6.4 μs

6.3875 μs

2.56 ms (high)

100 kHz

10 μs

2.56 ms

2.55 ms

Userconfigurable

1 Filter
Clock
period

Tuser

Tuser - (1 Filter
Clock period)

Filter Setting

Custom

*

Pulse widths are nominal values; the accuracy of the chassis timebase and I/O distortion will affect these
values.

On power up, the filters are disabled. Figure 5-7 shows an example of a low-to-high transition
on an input that has a custom filter set to N = 5.
Figure 5-7. PFI Filter Example
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1
Filter Clock

1

2

3

4

1

2

3

4

5

Filtered input goes
high when terminal
is sampled high on
five consecutive filter
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The cDAQ chassis has four general-purpose 32-bit counter/timers and one frequency generator.
The general-purpose counter/timers can be used for many measurement and pulse generation
applications. Figure 6-1 shows the cDAQ chassis Counter 0 and the frequency generator. All
four counters on the cDAQ chassis are identical.
Figure 6-1. Chassis Counter 0 and Frequency Generator
Counter 0

Input Selection Muxes

Counter 0 Source (Counter 0 Timebase)
Counter 0 Gate

Counter 0 Internal Output

Counter 0 Aux

Embedded Ctr0

Counter 0 HW Arm

FIFO

Counter 0 A
Counter 0 B (Counter 0 Up_Down)

Counter 0 TC

Counter 0 Z
Counter 0 Sample Clock

Input Selection Muxes

Frequency Generator
Frequency Output Timebase

Freq Out

Counters have eight input signals, although in most applications only a few inputs are used.
For information about connecting counter signals, refer to the Default Counter/Timer Routing
section.
Each counter has a FIFO that can be used for buffered acquisition and generation. Each counter
also contains an embedded counter (Embedded Ctrn) for use in what are traditionally
two-counter measurements and generations. The embedded counters cannot be programmed
independent of the main counter; signals from the embedded counters are not routable.
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Counter Timing Engine
Unlike analog input, analog output, digital input, and digital output, the cDAQ chassis counters
do not have the ability to divide down a timebase to produce an internal counter sample clock.
For sample clocked operations, an external signal must be provided to supply a clock source. The
source can be any of the following signals:
•
AI Sample Clock
•
AI Start Trigger
•
AI Reference Trigger
•
AO Sample Clock
•
DI Sample Clock
•
DI Start Trigger
•
DO Sample Clock
•
CTR n Internal Output
•
Freq Out
•
PFI
•
Change Detection Event
•
Analog Comparison Event
Not all timed counter operations require a sample clock. For example, a simple buffered pulse
width measurement latches in data on each edge of a pulse. For this measurement, the measured
signal determines when data is latched in. These operations are referred to as implicit timed
operations. However, many of the same measurements can be clocked at an interval with a
sample clock. These are referred to as sample clocked operations. Table 6-1 shows the different
options for the different measurements.
Table 6-1. Counter Timing Measurements
Implicit
Timing Support

Sample Clocked
Timing Support

Buffered Edge Count

No

Yes

Buffered Pulse Width

Yes

Yes

Buffered Pulse

Yes

Yes

Buffered Semi-Period

Yes

No

Buffered Frequency

Yes

Yes

Buffered Period

Yes

Yes

Buffered Position

No

Yes

Buffered Two-Signal Edge Separation

Yes

Yes

Measurement
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Counter Triggering
Counters support three different triggering actions:
•

Arm Start Trigger—To begin any counter input or output function, you must first enable,
or arm, the counter. Software can arm a counter or configure counters to be armed on a
hardware signal or a specific time. Software calls this hardware signal the Arm Start
Trigger. Internally, software routes the Arm Start Trigger to the Counter n HW Arm input
of the counter.
For counter output operations, you can use it in addition to the start and pause triggers. For
counter input operations, you can use the arm start trigger to have start trigger-like behavior.
The arm start trigger can be used for synchronizing multiple counter input and output tasks.
When using an arm start trigger, the arm start trigger source is routed to the Counter n HW
Arm signal.

•

Start Trigger—You can use the start trigger for counter output functions. You can
configure a start trigger to begin a finite or continuous pulse generation. After a continuous
generation has triggered, the pulses continue to generate until you stop the operation in
software. For finite generations, the specified number of pulses is generated and the
generation stops unless you use the retriggerable attribute. When you use this attribute,
subsequent start triggers cause the generation to restart.
When using a start trigger, the start trigger source is routed to the Counter n Gate signal
input of the counter. Possible triggers for counter output operations are a hardware signal
or a specific time.
For counter input functions, you can use the arm start trigger to have start trigger-like
behavior.

•

Pause Trigger—You can use pause triggers in edge counting and continuous pulse
generation applications. For edge counting acquisitions, the counter stops counting edges
while the external trigger signal is low and resumes when the signal goes high or vice versa.
For continuous pulse generations, the counter stops generating pulses while the external
trigger signal is low and resumes when the signal goes high or vice versa.
When using a pause trigger, the pause trigger source is routed to the Counter n Gate signal
input of the counter.

Counter Input Applications
The following sections list the various counter input applications available on the cDAQ chassis:
•

Counting Edges

•

Pulse-Width Measurement

•

Pulse Measurement

•

Semi-Period Measurement

•

Frequency Measurement
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•

Period Measurement

•

Position Measurement

Counting Edges
In edge counting applications, the counter counts edges on its Source after the counter is armed.
You can configure the counter to count rising or falling edges on its Source input. You also can
control the direction of counting (up or down), as described in the Controlling the Direction of
Counting section. The counter values can be read on demand or with a sample clock.
Refer to the following sections for more information about edge counting options:
•

Single Point (On-Demand) Edge Counting

•

Buffered (Sample Clock) Edge Counting

Single Point (On-Demand) Edge Counting
With single point (on-demand) edge counting, the counter counts the number of edges on the
Source input after the counter is armed. On-demand refers to the fact that software can read the
counter contents at any time without disturbing the counting process. Figure 6-2 shows an
example of single point edge counting.
Figure 6-2. Single Point (On-Demand) Edge Counting
Counter Armed
SOURCE
Counter Value

0

1

2

3

4

5

You also can use a pause trigger to pause (or gate) the counter. When the pause trigger is active,
the counter ignores edges on its Source input. When the pause trigger is inactive, the counter
counts edges normally.
You can route the pause trigger to the Gate input of the counter. You can configure the counter
to pause counting when the pause trigger is high or when it is low. Figure 6-3 shows an example
of on-demand edge counting with a pause trigger.
Figure 6-3. Single Point (On-Demand) Edge Counting with Pause Trigger
Counter Armed
Pause Trigger
(Pause When Low)
SOURCE
Counter Value

6-4

|

ni.com

0

0

1

2

3

4

5

cDAQ-9185/9189 User Manual

Buffered (Sample Clock) Edge Counting
With buffered edge counting (edge counting using a sample clock), the counter counts the
number of edges on the Source input after the counter is armed. The value of the counter is
sampled on each active edge of a sample clock and stored in the FIFO. The STC3 transfers the
sampled values to host memory using a high-speed data stream.
The count values returned are the cumulative counts since the counter armed event. That is, the
sample clock does not reset the counter. You can configure the counter to sample on the rising
or falling edge of the sample clock.
Figure 6-4 shows an example of buffered edge counting. Notice that counting begins when the
counter is armed, which occurs before the first active edge on Sample Clock.
Figure 6-4. Buffered (Sample Clock) Edge Counting
Counter Armed
Sample Clock
(Sample on Rising Edge)
SOURCE
Counter Value

0

1

2

3

4
3

Buffer

5

6

7
3
6

Controlling the Direction of Counting
In edge counting applications, the counter can count up or down. You can configure the counter
to do the following:
•

Always count up

•

Always count down

•

Count up when the Counter 0 B input is high; count down when it is low

For information about connecting counter signals, refer to the Default Counter/Timer Routing
section.
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Pulse-Width Measurement
In pulse-width measurements, the counter measures the width of a pulse on its Gate input signal.
You can configure the counter to measure the width of high pulses or low pulses on the Gate
signal.
You can route an internal or external periodic clock signal (with a known period) to the Source
input of the counter. The counter counts the number of rising (or falling) edges on the Source
signal while the pulse on the Gate signal is active.
You can calculate the pulse width by multiplying the period of the Source signal by the number
of edges returned by the counter.
A pulse-width measurement will be accurate even if the counter is armed while a pulse train is
in progress. If a counter is armed while the pulse is in the active state, it will wait for the next
transition to the active state to begin the measurement.
Refer to the following sections for more information about cDAQ chassis pulse-width
measurement options:
•

Single Pulse-Width Measurement

•

Implicit Buffered Pulse-Width Measurement

•

Sample Clocked Buffered Pulse-Width Measurement

Single Pulse-Width Measurement
With single pulse-width measurement, the counter counts the number of edges on the Source
input while the Gate input remains active. When the Gate input goes inactive, the counter stores
the count in the FIFO and ignores other edges on the Gate and Source inputs. Software then reads
the stored count.
Figure 6-5 shows an example of a single pulse-width measurement.
Figure 6-5. Single Pulse-Width Measurement

GATE

SOURCE
Counter Value

Latched Value
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Implicit Buffered Pulse-Width Measurement
An implicit buffered pulse-width measurement is similar to single pulse-width measurement, but
buffered pulse-width measurement takes measurements over multiple pulses.
The counter counts the number of edges on the Source input while the Gate input remains active.
On each trailing edge of the Gate signal, the counter stores the count in the counter FIFO. The
STC3 transfers the sampled values to host memory using a high-speed data stream.
Figure 6-6 shows an example of an implicit buffered pulse-width measurement.
Figure 6-6. Implicit Buffered Pulse-Width Measurement
GATE
SOURCE
Counter Value

0

1

3

2

1

2

3

Buffer

3

2

3
2

Sample Clocked Buffered Pulse-Width Measurement
A sample clocked buffered pulse-width measurement is similar to single pulse-width
measurement, but buffered pulse-width measurement takes measurements over multiple pulses
correlated to a sample clock.
The counter counts the number of edges on the Source input while the Gate input remains active.
On each sample clock edge, the counter stores the count in the FIFO of the last pulse width to
complete. The STC3 transfers the sampled values to host memory using a high-speed data
stream.
Figure 6-7 shows an example of a sample clocked buffered pulse-width measurement.
Figure 6-7. Sample Clocked Buffered Pulse-Width Measurement
Pulse
Source
2

2

4

2

2

3

Sample Clock
Buffer

Note

4
3

4

If a pulse does not occur between sample clocks, an overrun error occurs.

For information about connecting counter signals, refer to the Default Counter/Timer Routing
section.
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Pulse Measurement
In pulse measurements, the counter measures the high and low time of a pulse on its Gate input
signal after the counter is armed. A pulse is defined in terms of its high and low time, high and
low ticks or frequency and duty cycle. This is similar to the pulse-width measurement, except
that the inactive pulse is measured as well.
You can route an internal or external periodic clock signal (with a known period) to the Source
input of the counter. The counter counts the number of rising (or falling) edges occurring on the
Source input between two edges of the Gate signal.
You can calculate the high and low time of the Gate input by multiplying the period of the Source
signal by the number of edges returned by the counter.
Refer to the following sections for more information about cDAQ chassis pulse measurement
options:
•

Single Pulse Measurement

•

Implicit Buffered Pulse Measurement

•

Sample Clocked Buffered Pulse Measurement

Single Pulse Measurement
Single (on-demand) pulse measurement is equivalent to two single pulse-width measurements
on the high (H) and low (L) ticks of a pulse, as shown in Figure 6-8.
Figure 6-8. Single (On-Demand) Pulse Measurement
Counter Armed
Gate

Source
Latched
Value

H L
1

2

3

4

5

6

7

1

2

3

4

5

6

7

8

9

10

7 10

Implicit Buffered Pulse Measurement
In an implicit buffered pulse measurement, on each edge of the Gate signal, the counter stores
the count in the FIFO. The STC3 transfers the sampled values to host memory using a
high-speed data stream.
The counter begins counting when it is armed. The arm usually occurs between edges on the
Gate input but the counting does not start until the desired edge. You can select whether to read
the high pulse or low pulse first using the StartingEdge property in NI-DAQmx.
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Figure 6-9 shows an example of an implicit buffered pulse measurement.
Figure 6-9. Implicit Buffered Pulse Measurement
Counter Armed
Gate
Source
H L
4 2

Buffer

H L
4 2
4 4

H
4
4
6

L
2
4
2

H
4
4
6
2

L
2
4
2
2

Sample Clocked Buffered Pulse Measurement
A sample clocked buffered pulse measurement is similar to single pulse measurement, but a
buffered pulse measurement takes measurements over multiple pulses correlated to a sample
clock.
The counter performs a pulse measurement on the Gate. On each sample clock edge, the counter
stores the high and low ticks in the FIFO of the last pulse to complete. The STC3 transfers the
sampled values to host memory using a high-speed data stream.
Figure 6-10 shows an example of a sample clocked buffered pulse measurement.
Figure 6-10. Sample Clocked Buffered Pulse Measurement
Counter
Armed

S2

S1

Gate
Source
Sample
Clock
Buffer

2

Note

2

HL
2 2

3

3

H L
2 2
3 3

If a pulse does not occur between sample clocks, an overrun error occurs.

For information about connecting counter signals, refer to the Default Counter/Timer Routing
section.
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Semi-Period Measurement
In semi-period measurements, the counter measures a semi-period on its Gate input signal after
the counter is armed. A semi-period is the time between any two consecutive edges on the Gate
input.
You can route an internal or external periodic clock signal (with a known period) to the Source
input of the counter. The counter counts the number of rising (or falling) edges occurring on the
Source input between two edges of the Gate signal.
You can calculate the semi-period of the Gate input by multiplying the period of the Source
signal by the number of edges returned by the counter.
Refer to the following sections for more information about semi-period measurement options:
•

Single Semi-Period Measurement

•

Implicit Buffered Semi-Period Measurement

Refer to the Pulse versus Semi-Period Measurements section for information about the
differences between semi-period measurement and pulse measurement.

Single Semi-Period Measurement
Single semi-period measurement is equivalent to single pulse-width measurement.

Implicit Buffered Semi-Period Measurement
In implicit buffered semi-period measurements, on each edge of the Gate signal, the counter
stores the count in the FIFO. The STC3 transfers the sampled values to host memory using a
high-speed data stream.
The counter begins counting when it is armed. The arm usually occurs between edges on the
Gate input. You can select whether to read the first active low or active high semi-period using
the CI.SemiPeriod.StartingEdge property in NI-DAQmx.
Figure 6-11 shows an example of an implicit buffered semi-period measurement.
Figure 6-11. Implicit Buffered Semi-Period Measurement
Counter
Armed

Starting
Edge

GATE
SOURCE
Counter Value
Buffer

0

1

2

3
3 3

1

1
1 3
1

1

2
2 3
1
2

For information about connecting counter signals, refer to the Default Counter/Timer Routing
section.
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Pulse versus Semi-Period Measurements
In hardware, pulse measurement and semi-period are the same measurement. Both measure the
high and low times of a pulse. The functional difference between the two measurements is how
the data is returned. In a semi-period measurement, each high or low time is considered one point
of data and returned in units of seconds or ticks. In a pulse measurement, each pair of high and
low times is considered one point of data and returned as a paired sample in units of frequency
and duty cycle, high and low time or high and low ticks. When reading data, 10 points in a
semi-period measurement will get an array of five high times and five low times. When you
read 10 points in a pulse measurement, you get an array of 10 pairs of high and low times.
Also, pulse measurements support sample clock timing while semi-period measurements do not.

Frequency Measurement
You can use the counters to measure frequency in several different ways. Refer to the following
sections for information about cDAQ chassis frequency measurement options:
•

Low Frequency with One Counter

•

High Frequency with Two Counters

•

Large Range of Frequencies with Two Counters

•

Sample Clocked Buffered Frequency Measurement

Low Frequency with One Counter
For low frequency measurements with one counter, you measure one period of your signal using
a known timebase.
You can route the signal to measure (fx) to the Gate of a counter. You can route a known timebase
(fk) to the Source of the counter. The known timebase can be an onboard timebase, such as
80 MHz Timebase, 20 MHz Timebase, or 100 kHz Timebase, or any other signal with a known
rate.
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You can configure the counter to measure one period of the gate signal. The frequency of fx is
the inverse of the period. Figure 6-12 illustrates this method.
Figure 6-12. Low Frequency with One Counter
Interval Measured
fx
fx

Gate

fk

Source

1

Single Period
Measurement

2

3

…

…

N

fk
Period of fx =

N
fk

Frequency of fx =

fk
N

High Frequency with Two Counters
For high frequency measurements with two counters, you measure one pulse of a known width
using your signal and derive the frequency of your signal from the result.
Counter 0 is always paired with Counter 1. Counter 2 is always paired with
Counter 3.
Note

In this method, you route a pulse of known duration (T) to the Gate of a counter. You can
generate the pulse using a second counter. You also can generate the pulse externally and connect
it to a PFI terminal. You only need to use one counter if you generate the pulse externally.
Route the signal to measure (fx) to the Source of the counter. Configure the counter for a single
pulse-width measurement. If you measure the width of pulse T to be N periods of fx, the
frequency of fx is N/T.
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Figure 6-13 illustrates this method. Another option is to measure the width of a known period
instead of a known pulse.
Figure 6-13. High Frequency with Two Counters
Width of Pulse (T )
Pulse
Pulse

Gate
1

fx

Source
Pulse-Width
Measurement

2

…

N

fx
Width of T =
Pulse
Frequency of fx =

N
fx
N
T

Large Range of Frequencies with Two Counters
By using two counters, you can accurately measure a signal that might be high or low frequency.
This technique is called reciprocal frequency measurement. When measuring a large range of
frequencies with two counters, you generate a long pulse using the signal to measure. You then
measure the long pulse with a known timebase. The cDAQ chassis can measure this long pulse
more accurately than the faster input signal.
Note Counter 0 is always paired with Counter 1. Counter 2 is always paired with
Counter 3.
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You can route the signal to measure to the Source input of Counter 0, as shown in Figure 6-14.
Assume this signal to measure has frequency fx. NI-DAQmx automatically configures Counter
0 to generate a single pulse that is the width of N periods of the source input signal.
Figure 6-14. Large Range of Frequencies with Two Counters
Signal to
Measure (fx)

Source

Out
Counter 0

Signal of Known
Frequency (fk)

Source

Out
Counter 1

Gate

CTR_0_SOURCE
(Signal to Measure)
CTR_0_OUT
(CTR_1_GATE)

0

1

2

3 … N

Interval
to Measure

CTR_1_SOURCE

Next, route the Counter 0 Internal Output signal to the Gate input of Counter 1. You can route a
signal of known frequency (fk) to the Counter 1 Source input. Configure Counter 1 to perform
a single pulse-width measurement. Suppose the result is that the pulse width is J periods of the
fk clock.
From Counter 0, the length of the pulse is N/fx. From Counter 1, the length of the same pulse is
J/fk. Therefore, the frequency of fx is given by fx = fk * (N/J).

Sample Clocked Buffered Frequency Measurement
Sample clocked buffered point frequency measurements can either be a single frequency
measurement or an average between sample clocks. Use CI.Freq.EnableAveraging to set the
behavior. For buffered frequency, the default is True.
A sample clocked buffered frequency measurement with CI.Freq.EnableAveraging set to True
uses the embedded counter and a sample clock to perform a frequency measurement. For each
sample clock period, the embedded counter counts the signal to measure (fx) and the primary
counter counts the internal time-base of a known frequency (fk). Suppose T1 is the number of
ticks of the unknown signal counted between sample clocks and T2 is the number of ticks
counted of the known timebase as shown in Figure 6-15. The frequency measured is:
fx = fk * (T1/T2)
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Figure 6-15. Sample Clocked Buffered Frequency Measurement (Averaging)
Counter Armed
S1

S2

S3

Gate
(fx)
1

2

1

6

10

6

Source
(fk)
Sample
Clock

T1 T2
1 6

Buffer

T1 T2
1 7
2 10

T1T2
1 7
2 10
1 6

When CI.Freq.EnableAveraging is set to false, the frequency measurement returns the
frequency of the pulse just before the sample clock. This single measurement is a single
frequency measurement and is not an average between clocks as shown in Figure 6-16.
Figure 6-16. Sample Clocked Buffered Frequency Measurement (Non-Averaging)
Counter Armed

Gate
Source
Sample
Clock
Latched
Values

6

4

6

6

6
4

6
4
6

With sample clocked frequency measurements, ensure that the frequency to measure is twice as
fast as the sample clock to prevent a measurement overflow.

Choosing a Method for Measuring Frequency
The best method to measure frequency depends on several factors including the expected
frequency of the signal to measure, the desired accuracy, how many counters are available, and
how long the measurement can take. For all frequency measurement methods, assume the
following:
fx

is the frequency to be measured if no error

fk

is the known source or gate frequency

measurement time (T)

is the time it takes to measure a single sample
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Divide down (N)

is the integer to divide down measured frequency, only used in
large range two counters

fs

is the sample clock rate, only used in sample clocked frequency
measurements

Here is how these variables apply to each method, summarized in Table 6-2.
•

One counter—With one counter measurements, a known timebase is used for the source
frequency (fk). The measurement time is the period of the frequency to be measured, or
1/fx.

•

Two counter high frequency—With the two counter high frequency method, the second
counter provides a known measurement time. The gate frequency equals 1/measurement
time.

•

Two counter large range—The two counter larger range measurement is the same as a one
counter measurement, but now the user has an integer divide down of the signal. An internal
timebase is still used for the source frequency (fk), but the divide down means that the
measurement time is the period of the divided down signal, or N/fx where N is the divide
down.

•

Sample clocked—For sample clocked frequency measurements, a known timebase is
counted for the source frequency (fk). The measurement time is the period of the sample
clock (fs).
Table 6-2. Frequency Measurement Methods
Two Counters
Variable

fk

Measurement
time
Max.
frequency
error
Max. error %

One
Counter

High
Frequency

Known timebase

Known
timebase

1
------------------------------gating period

1
---fs

1
---fx

Sample Clocked

fx
fx × ------------------------------fx
fk × ---- – 1
fs
fx
------------------------------fx
fk × ---- – 1
fs

fx
fx × --------------fk – fx
fx
--------------fk – fx

Large Range

Known timebase

gating period

N
---fx

fk

fx
fx × ------------------------N × fk – fx

fk
---fx

fx
------------------------N × fk – fx

Note: Accuracy equations do not take clock stability into account. Refer to the specifications document
for your chassis for information about clock stability.
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Which Method Is Best?
This depends on the frequency to be measured, the rate at which you want to monitor the
frequency and the accuracy you desire. Take for example, measuring a 50 kHz signal. Assuming
that the measurement times for the sample clocked (with averaging) and two counter frequency
measurements are configured the same, Table 6-3 summarizes the results.
Table 6-3. 50 kHz Frequency Measurement Methods
Two Counters
Sample
Clocked

One Counter

High
Frequency

Large Range

fx

50,000

50,000

50,000

50,000

fk

80 M

80 M

1,000

80 M

Measurement
time (ms)

1

.02

1

1

N

—

—

—

50

.638

31.27

1,000

.625

.00128

.0625

2

.00125

Variable

Max. frequency
error (Hz)
Max. error %

From this, you can see that while the measurement time for one counter is shorter, the accuracy
is best in the sample clocked and two counter large range measurements. For another example,
Table 6-4 shows the results for 5 MHz.
Table 6-4. 5 MHz Frequency Measurement Methods
Two Counters
Sample Clocked

One Counter

High
Frequency

Large Range

fx

5M

5M

5M

5M

fk

80 M

80 M

1,000

80 M

Measurement
time (ms)

1

.0002

1

1

N

—

—

—

5,000

Max.
Frequency
error (Hz)

62.51

333 k

1,000

62.50

Max. Error %

.00125

6.67

.02

.00125

Variable
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Again, the measurement time for the one counter measurement is lowest but the accuracy is
lower. Note that the accuracy and measurement time of the sample clocked and two counter large
range are almost the same. The advantage of the sample clocked method is that even when the
frequency to measure changes, the measurement time does not and error percentage varies little.
For example, if you configured a large range two-counter measurement to use a divide down of
50 for a 50 k signal, then you would get the accuracy measurement time and accuracy listed in
Table 6-3. But if your signal ramped up to 5 M, then with a divide down of 50, your measurement
time is 0.01 ms, but your error is now 0.125%. The error with a sample clocked frequency
measurement is not as dependent on the measured frequency so at 50 k and 5 M with a
measurement time of 1 ms the error percentage is still close to 0.00125%. One of the
disadvantages of a sample clocked frequency measurement is that the frequency to be measured
must be at least twice the sample clock rate to ensure that a full period of the frequency to be
measured occurs between sample clocks.
•
Low frequency measurements with one counter is a good method for many applications.
However, the accuracy of the measurement decreases as the frequency increases.
•
High frequency measurements with two counters is accurate for high frequency signals.
However, the accuracy decreases as the frequency of the signal to measure decreases. At
very low frequencies, this method may be too inaccurate for your application. Another
disadvantage of this method is that it requires two counters (if you cannot provide an
external signal of known width). An advantage of high frequency measurements with
two counters is that the measurement completes in a known amount of time.
•
Measuring a large range of frequencies with two counters measures high and low frequency
signals accurately. However, it requires two counters, and it has a variable sample time and
variable error % dependent on the input signal.
Table 6-5 summarizes some of the differences in methods of measuring frequency.
Table 6-5. 5 MHz Frequency Measurement Methods
Two Counters

Sample
Clocked
(Averaged)

One Counter

High
Frequency

Large Range

Number of
counters used

1

1

1 or 2

2

Number of
measurements
returned

1

1

1

1

Method
Comparison
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Table 6-5. 5 MHz Frequency Measurement Methods (Continued)
Two Counters

Sample
Clocked
(Averaged)

One Counter

High
Frequency

Large Range

Measures high
frequency
signals
accurately

Good

Poor

Good

Good

Measures low
frequency
signals
accurately

Good

Good

Good

Poor

Method
Comparison

For information about connecting counter signals, refer to the Default Counter/Timer Routing
section.

Period Measurement
In period measurements, the counter measures a period on its Gate input signal after the counter
is armed. You can configure the counter to measure the period between two rising edges or
two falling edges of the Gate input signal.
You can route an internal or external periodic clock signal (with a known period) to the Source
input of the counter. The counter counts the number of rising (or falling) edges occurring on the
Source input between the two active edges of the Gate signal.
You can calculate the period of the Gate input by multiplying the period of the Source signal by
the number of edges returned by the counter.
Period measurements return the inverse results of frequency measurements. Refer to the
Frequency Measurement section for more information.

Position Measurement
You can use the counters to perform position measurements with quadrature encoders or
two-pulse encoders. You can measure angular position with X1, X2, and X4 angular encoders.
Linear position can be measured with two-pulse encoders. You can choose to do either a single
point (on-demand) position measurement or a buffered (sample clock) position measurement.
You must arm a counter to begin position measurements.
Refer to the following sections for more information about the cDAQ chassis position
measurement options:
•

Measurements Using Quadrature Encoders

•

Measurements Using Two Pulse Encoders

•

Buffered (Sample Clock) Position Measurement
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Measurements Using Quadrature Encoders
The counters can perform measurements of quadrature encoders that use X1, X2, or X4
encoding. A quadrature encoder can have up to three channels—channels A, B, and Z.
•

X1 Encoding—When channel A leads channel B in a quadrature cycle, the counter
increments. When channel B leads channel A in a quadrature cycle, the counter
decrements. The amount of increments and decrements per cycle depends on the type of
encoding—X1, X2, or X4.
Figure 6-17 shows a quadrature cycle and the resulting increments and decrements for X1
encoding. When channel A leads channel B, the increment occurs on the rising edge of
channel A. When channel B leads channel A, the decrement occurs on the falling edge of
channel A.
Figure 6-17. X1 Encoding
Ch A
Ch B
Counter Value 5

•

6

7

7

5

6

X2 Encoding—The same behavior holds for X2 encoding except the counter increments
or decrements on each edge of channel A, depending on which channel leads the other.
Each cycle results in two increments or decrements, as shown in Figure 6-18.
Figure 6-18. X2 Encoding
Ch A
Ch B
Counter Value 5

•

6

9

8

7

9

7

8

6

5

X4 Encoding—Similarly, the counter increments or decrements on each edge of
channels A and B for X4 encoding. Whether the counter increments or decrements depends
on which channel leads the other. Each cycle results in four increments or decrements, as
shown in Figure 6-19.
Figure 6-19. X4 Encoding
Ch A
Ch B
Counter Value
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Channel Z Behavior
Some quadrature encoders have a third channel, channel Z, which is also referred to as the index
channel. A high level on channel Z causes the counter to be reloaded with a specified value in a
specified phase of the quadrature cycle. You can program this reload to occur in any one of the
four phases in a quadrature cycle.
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Channel Z behavior—when it goes high and how long it stays high—differs with quadrature
encoder designs. You must refer to the documentation for your quadrature encoder to obtain
timing of channel Z with respect to channels A and B. You must then ensure that channel Z is
high during at least a portion of the phase you specify for reload. For instance, in Figure 6-20,
channel Z is never high when channel A is high and channel B is low. Thus, the reload must
occur in some other phase.
In Figure 6-20, the reload phase is when both channel A and channel B are low. The reload
occurs when this phase is true and channel Z is high. Incrementing and decrementing takes
priority over reloading. Thus, when the channel B goes low to enter the reload phase, the
increment occurs first. The reload occurs within one maximum timebase period after the
reload phase becomes true. After the reload occurs, the counter continues to count as before.
The figure illustrates channel Z reload with X4 decoding.
Figure 6-20. Channel Z Reload with X4 Decoding
Ch A
Ch B
Ch Z
Max Timebase
Counter Value

5

6

7

8

9
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4

A=0
B=0
Z=1

Measurements Using Two Pulse Encoders
The counter supports two pulse encoders that have two channels—channels A and B.
The counter increments on each rising edge of channel A. The counter decrements on each rising
edge of channel B, as shown in Figure 6-21.
Figure 6-21. Measurements Using Two Pulse Encoders
Ch A
Ch B
Counter Value 2

3

4

5

4

3

4

For information about connecting counter signals, refer to the Default Counter/Timer Routing
section.

Buffered (Sample Clock) Position Measurement
With buffered position measurement (position measurement using a sample clock), the counter
increments based on the encoding used after the counter is armed. The value of the counter is
sampled on each active edge of a sample clock. The STC3 transfers the sampled values to host
memory using a high-speed data stream. The count values returned are the cumulative counts
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since the counter armed event; that is, the sample clock does not reset the counter. You can route
the counter sample clock to the Gate input of the counter. You can configure the counter to
sample on the rising or falling edge of the sample clock.
Figure 6-22 shows an example of a buffered X1 position measurement.
Figure 6-22. Buffered Position Measurement
Sample Clock
(Sample on Rising Edge)

Counter
Armed

Ch A
Ch B
Count
Buffer

0

1

2

1

3

4

1
3

Two-Signal Edge-Separation Measurement
Two-signal edge-separation measurement is similar to pulse-width measurement, except that
there are two measurement signals—Aux and Gate. An active edge on the Aux input starts the
counting and an active edge on the Gate input stops the counting. You must arm a counter to
begin a two edge separation measurement.
After the counter has been armed and an active edge occurs on the Aux input, the counter counts
the number of rising (or falling) edges on the Source. The counter ignores additional edges on
the Aux input.
The counter stops counting upon receiving an active edge on the Gate input. The counter stores
the count in the FIFO.
You can configure the rising or falling edge of the Aux input to be the active edge. You can
configure the rising or falling edge of the Gate input to be the active edge.
Use this type of measurement to count events or measure the time that occurs between
edges on two signals. This type of measurement is sometimes referred to as start/stop trigger
measurement, second gate measurement, or A-to-B measurement.
Refer to the following sections for more information about the cDAQ chassis edge-separation
measurement options:
•

Single Two-Signal Edge-Separation Measurement

•

Implicit Buffered Two-Signal Edge-Separation Measurement

•

Sample Clocked Buffered Two-Signal Separation Measurement
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Single Two-Signal Edge-Separation Measurement
With single two-signal edge-separation measurement, the counter counts the number of rising
(or falling) edges on the Source input occurring between an active edge of the Gate signal and
an active edge of the Aux signal. The counter then stores the count in the FIFO and ignores other
edges on its inputs. Software then reads the stored count.
Figure 6-23 shows an example of a single two-signal edge-separation measurement.
Figure 6-23. Single Two-Signal Edge-Separation Measurement
Counter
Armed
Measured Interval
AUX
GATE
SOURCE
Counter Value

0

0

0

0

1

2

3

4
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6

7

Latched Value

8

8

8

8

Implicit Buffered Two-Signal Edge-Separation Measurement
Implicit buffered and single two-signal edge-separation measurements are similar, but implicit
buffered measurement measures multiple intervals.
The counter counts the number of rising (or falling) edges on the Source input occurring between
an active edge of the Gate signal and an active edge of the Aux signal. The counter then stores
the count in the FIFO. On the next active edge of the Gate signal, the counter begins another
measurement. The STC3 transfers the sampled values to host memory using a high-speed data
stream.
Figure 6-24 shows an example of an implicit buffered two-signal edge-separation measurement.
Figure 6-24. Implicit Buffered Two-Signal Edge-Separation Measurement
AUX
GATE
SOURCE
Counter Value

1

2

3

1
3

Buffer

2

3
3
3

1

2

3
3
3
3

Sample Clocked Buffered Two-Signal Separation Measurement
A sample clocked buffered two-signal separation measurement is similar to single two-signal
separation measurement, but buffered two-signal separation measurement takes measurements
over multiple intervals correlated to a sample clock. The counter counts the number of rising (or
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falling) edges on the Source input occurring between an active edge of the Gate signal and an
active edge of the Aux signal. The counter then stores the count in the FIFO on a sample clock
edge. On the next active edge of the Gate signal, the counter begins another measurement. The
STC3 transfers the sampled values to host memory using a high-speed data stream.
Figure 6-25 shows an example of a sample clocked buffered two-signal separation
measurement.
Figure 6-25. Sample Clocked Buffered Two-Signal Separation Measurement
Sample
Clock
AUX
GATE
SOURCE
Counter Value

1

2

3

1

2
3

Buffer

3

1

2

3
3
3

If an active edge on the Gate and an active edge on the Aux does not occur
between sample clocks, an overrun error occurs.
Note

For information about connecting counter signals, refer to the Default Counter/Timer Routing
section.

Counter Output Applications
The following sections list the various counter output applications available on the cDAQ
chassis:
•

Simple Pulse Generation

•

Pulse Train Generation

•

Frequency Generation

•

Frequency Division

•

Using the Watchdog Timer

•

Pulse Generation for ETS

Simple Pulse Generation
Refer to the following sections for more information about the cDAQ chassis simple pulse
generation options:
•

Single Pulse Generation

•

Single Pulse Generation with Start Trigger
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Single Pulse Generation
The counter can output a single pulse. The pulse appears on the Counter n Internal Output signal
of the counter.
You can specify a delay from when the counter is armed to the beginning of the pulse. The delay
is measured in terms of a number of active edges of the Source input.
You can specify a pulse width. The pulse width is also measured in terms of a number of active
edges of the Source input. You also can specify the active edge of the Source input (rising or
falling).
Figure 6-26 shows a generation of a pulse with a pulse delay of four and a pulse width of three
(using the rising edge of Source).
Figure 6-26. Single Pulse Generation
Counter Armed
SOURCE
OUT

Single Pulse Generation with Start Trigger
The counter can output a single pulse in response to one pulse on a hardware Start Trigger signal.
The pulse appears on the Counter n Internal Output signal of the counter.
You can specify a delay from the Start Trigger to the beginning of the pulse. You also can specify
the pulse width. The delay is measured in terms of a number of active edges of the Source input.
You can specify a pulse width. The pulse width is also measured in terms of a number of active
edges of the Source input. You can also specify the active edge of the Source input (rising and
falling).
Figure 6-27 shows a generation of a pulse with a pulse delay of four and a pulse width of three
(using the rising edge of Source).
Figure 6-27. Single Pulse Generation with Start Trigger
GATE
(Start Trigger)
SOURCE
OUT
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Pulse Train Generation
Refer to the following sections for more information about the cDAQ chassis pulse train
generation options:
•

Finite Pulse Train Generation

•

Retriggerable Pulse or Pulse Train Generation

•

Continuous Pulse Train Generation

•

Buffered Pulse Train Generation

•

Finite Implicit Buffered Pulse Train Generation

•

Continuous Buffered Implicit Pulse Train Generation

•

Finite Buffered Sample Clocked Pulse Train Generation

•

Continuous Buffered Sample Clocked Pulse Train Generation

Finite Pulse Train Generation
This function generates a train of pulses with programmable frequency and duty cycle for a
predetermined number of pulses. With cDAQ chassis counters, the primary counter generates
the specified pulse train and the embedded counter counts the pulses generated by the primary
counter. When the embedded counter reaches the specified tick count, it generates a trigger that
stops the primary counter generation.
Figure 6-28. Finite Pulse Train Generation: Four Ticks Initial Delay, Four Pulses
Counter Armed
Source

Enablex

Ctrx

Retriggerable Pulse or Pulse Train Generation
The counter can output a single pulse or multiple pulses in response to each pulse on a hardware
Start Trigger signal. The generated pulses appear on the Counter n Internal Output signal of the
counter.
You can route the Start Trigger signal to the Gate input of the counter. You can specify a delay
from the Start Trigger to the beginning of each pulse. You also can specify the pulse width.
The delay and pulse width are measured in terms of a number of active edges of the Source
input. The initial delay can be applied to only the first trigger or to all triggers using the
CO.EnableInitalDelayOnRetrigger property. The default for a single pulse is True, while
the default for finite pulse trains is False.
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The counter ignores the Gate input while a pulse generation is in progress. After the pulse
generation is finished, the counter waits for another Start Trigger signal to begin another pulse
generation. For retriggered pulse generation, pause triggers are not allowed since the pause
trigger also uses the gate input.
Figure 6-29 shows a generation of two pulses with a pulse delay of five and a pulse width of
three (using the rising edge of Source) with CO.EnableInitalDelayOnRetrigger set to the
default True.
Figure 6-29. Retriggerable Single Pulse Generation with Initial Delay on Retrigger
Counter
Load Values

4 3 2 1 0 2 1 0

4 3 2 1 0 2 1 0

GATE
(Start Trigger)
SOURCE
OUT
5

3

5

3

Figure 6-30 shows the same pulse train with CO.EnableInitalDelayOnRetrigger set to the
default False.
Figure 6-30. Retriggerable Single Pulse Generation False
Counter
Load Values

4 3 2 1 0 2 1 0

4 3 2 1 0 2 1 0

GATE
(Start Trigger)
SOURCE
OUT
5

3

2

3

Note The minimum time between the trigger and the first active edge is two ticks
of the source.

For information about connecting counter signals, refer to the Default Counter/Timer Routing
section.

Continuous Pulse Train Generation
This function generates a train of pulses with programmable frequency and duty cycle. The
pulses appear on the Counter n Internal Output signal of the counter.
You can specify a delay from when the counter is armed to the beginning of the pulse train. The
delay is measured in terms of a number of active edges of the Source input.
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You specify the high and low pulse widths of the output signal. The pulse widths are also
measured in terms of a number of active edges of the Source input. You also can specify the
active edge of the Source input (rising or falling).
The counter can begin the pulse train generation as soon as the counter is armed, or in response
to a hardware Start Trigger. You can route the Start Trigger to the Gate input of the counter.
You also can use the Gate input of the counter as a Pause Trigger (if it is not used as a Start
Trigger). The counter pauses pulse generation when the Pause Trigger is active.
Figure 6-31 shows a continuous pulse train generation (using the rising edge of Source).
Figure 6-31. Continuous Pulse Train Generation

SOURCE
OUT
Counter Armed

Continuous pulse train generation is sometimes called frequency division. If the high and low
pulse widths of the output signal are M and N periods, then the frequency of the Counter n
Internal Output signal is equal to the frequency of the Source input divided by M + N.
For information about connecting counter signals, refer to the Default Counter/Timer Routing
section.

Buffered Pulse Train Generation
The cDAQ chassis counters can use the FIFO to perform a buffered pulse train generation. This
pulse train can use implicit timing or sample clock timing. When using implicit timing, the pulse
idle time and active time changes with each sample you write. With sample clocked timing, each
sample you write updates the idle time and active time of your generation on each sample clock
edge. Idle time and active time can also be defined in terms of frequency and duty cycle or idle
ticks and active ticks.
On buffered implicit pulse trains, the pulse specifications in the DAQmx
Create Counter Output Channel are ignored so that you generate the number of pulses
defined in the multipoint write. On buffered sample clock pulse trains, the pulse
specifications in the DAQmx Create Counter Output Channel are generated after the
counters starts and before the first sample clock so that you generate the number of
updates defined in the multipoint write.
Note
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Finite Implicit Buffered Pulse Train Generation
This function generates a predetermined number of pulses with variable idle and active times.
Each point you write generates a single pulse. The number of pairs of idle and active times (pulse
specifications) you write determines the number of pulses generated. All points are generated
back to back to create a user defined pulse train.
Table 6-6 and Figure 6-32 detail a finite implicit generation of three samples.
Table 6-6. Finite Implicit Buffered Pulse Train Generation
Sample

Idle Ticks

Active Ticks

1

2

2

2

3

4

3

2

2

Figure 6-32. Finite Implicit Buffered Pulse Train Generation

SOURCE
OUT
2

2

3

4

2

2

Counter Armed

Continuous Buffered Implicit Pulse Train Generation
This function generates a continuous train of pulses with variable idle and active times. Instead
of generating a set number of data samples and stopping, a continuous generation continues until
you stop the operation. Each point you write generates a single pulse. All points are generated
back to back to create a user defined pulse train.

Finite Buffered Sample Clocked Pulse Train Generation
This function generates a predetermined number of pulse train updates. Each point you write
defines pulse specifications that are updated with each sample clock. When a sample clock
occurs, the current pulse (idle followed by active) finishes generation and the next pulse updates
with the next sample specifications.
When the last sample is generated, the pulse train continues to generate with
these specifications until the task is stopped.

Note
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Table 6-7 and Figure 6-33 detail a finite sample clocked generation of three samples where the
pulse specifications from the create channel are two ticks idle, two ticks active, and three ticks
initial delay.
Table 6-7. Finite Buffered Sample Clocked Pulse Train Generation
Sample

Idle Ticks

Active Ticks

1

3

3

2

2

2

3

3

3

Figure 6-33. Finite Buffered Sample Clocked Pulse Train Generation
Counter Armed
Sample
Clock
Counter
Load Values

2 1 0 1 0 1 0 1 0 2 1 0 2 1 0 2 1 0 2 1 0 1 0 1 0 2 1 0 2 1 0

Source
Out
3

2

2

2

3

3

3

3

2

2

3

3

There are several different methods of continuous generation that control what data is written.
These methods are regeneration, FIFO regeneration, and non-regeneration modes.
Regeneration is the repetition of the data that is already in the buffer.
Standard regeneration is when data from the PC buffer is continually downloaded to the FIFO
to be written out. New data can be written to the PC buffer at any time without disrupting the
output. With FIFO regeneration, the entire buffer is downloaded to the FIFO and regenerated
from there. Once the data is downloaded, new data cannot be written to the FIFO. To use FIFO
regeneration, the entire buffer must fit within the FIFO size. The advantage of using FIFO
regeneration is that it does not require communication with the main host memory once the
operation is started, thereby preventing any problems that may occur due to excessive bus traffic.
With non-regeneration, old data is not repeated. New data must be continually written to the
buffer. If the program does not write new data to the buffer at a fast enough rate to keep up with
the generation, the buffer underflows and causes an error.
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Continuous Buffered Sample Clocked Pulse Train Generation
This function generates a continuous train of pulses with variable idle and active times. Instead
of generating a set number of data samples and stopping, a continuous generation continues until
you stop the operation. Each point you write specifies pulse specifications that are updated with
each sample clock. When a sample clock occurs, the current pulse finishes generation and the
next pulse uses the next sample specifications.

Frequency Generation
You can generate a frequency by using a counter in pulse train generation mode or by using the
frequency generator circuit, as described in the Using the Frequency Generator section.

Using the Frequency Generator
The frequency generator can output a square wave at many different frequencies. The frequency
generator is independent of the four general-purpose 32-bit counter/timer modules on the cDAQ
chassis.
Figure 6-34 shows a block diagram of the frequency generator.
Figure 6-34. Frequency Generator Block Diagram

20 MHz Timebase

÷2

Frequency
Output
Timebase
Frequency Generator

FREQ OUT

100 kHz Timebase
Divisor
(1–16)

The frequency generator generates the Frequency Output signal. The Frequency Output signal
is the Frequency Output Timebase divided by a number you select from 1 to 16. The Frequency
Output Timebase can be either the 20 MHz Timebase, the 20 MHz Timebase divided by 2, or
the 100 kHz Timebase.
The duty cycle of Frequency Output is 50% if the divider is either 1 or an even number.
For an odd divider, suppose the divider is set to D. In this case, Frequency Output is low for
(D + 1)/2 cycles and high for (D - 1)/2 cycles of the Frequency Output Timebase.
Figure 6-35 shows the output waveform of the frequency generator when the divider is set to 5.
Figure 6-35. Frequency Generator Output Waveform
Frequency
Output
Timebase
FREQ OUT
(Divisor = 5)
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Frequency Output can be routed out to any PFI terminal. All PFI terminals are set to
high-impedance at startup. The FREQ OUT signal also can be routed to many internal timing
signals.
In software, program the frequency generator as you would program one of the counters for
pulse train generation.
For information about connecting counter signals, refer to the Default Counter/Timer Routing
section.

Frequency Division
The counters can generate a signal with a frequency that is a fraction of an input signal. This
function is equivalent to continuous pulse train generation. Refer to the Continuous Pulse Train
Generation section for detailed information.
For information about connecting counter signals, refer to the Default Counter/Timer Routing
section.

Using the Watchdog Timer
You can use the watchdog timer for counter output operations. Refer to the Watchdog Timer
section of Chapter 1, Getting Started with the cDAQ Chassis, for more information.

Pulse Generation for ETS
In the equivalent time sampling (ETS) application, the counter produces a pulse on the output
a specified delay after an active edge on Gate. After each active edge on Gate, the counter
cumulatively increments the delay between the Gate and the pulse on the output by a specified
amount. Thus, the delay between the Gate and the pulse produced successively increases.
The increase in the delay value can be between 0 and 255. For instance, if you specify the
increment to be 10, the delay between the active Gate edge and the pulse on the output increases
by 10 every time a new pulse is generated.
Suppose you program your counter to generate pulses with a delay of 100 and pulse width of 200
each time it receives a trigger. Furthermore, suppose you specify the delay increment to be 10.
On the first trigger, your pulse delay will be 100, on the second it will be 110, on the third it will
be 120; the process will repeat in this manner until the counter is disarmed. The counter ignores
any Gate edge that is received while the pulse triggered by the previous Gate edge is in progress.
The waveform thus produced at the counter’s output can be used to provide timing for
undersampling applications where a digitizing system can sample repetitive waveforms that are
higher in frequency than the Nyquist frequency of the system. Figure 6-36 shows an example of
pulse generation for ETS; the delay from the trigger to the pulse increases after each subsequent
Gate active edge.
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Figure 6-36. Pulse Generation for ETS

GATE

OUT
D1

D2 = D1 + ΔD

D3 = D1 + 2ΔD

For information about connecting counter signals, refer to the Default Counter/Timer Routing
section.

Counter Timing Signals
The cDAQ chassis features the following counter timing signals:
•

Counter n Source Signal

•

Counter n Gate Signal

•

Counter n Aux Signal

•

Counter n A Signal

•

Counter n B Signal

•

Counter n Z Signal

•

Counter n Up_Down Signal

•

Counter n HW Arm Signal

•

Counter n Sample Clock Signal

•

Counter n Internal Output Signal

•

Counter n TC Signal

•

Frequency Output Signal

In this section, n refers to the cDAQ chassis Counter 0, 1, 2, or 3. For example, Counter n Source
refers to four signals—Counter 0 Source (the source input to Counter 0), Counter 1 Source (the
source input to Counter 1), Counter 2 Source (the source input to Counter 2), or Counter 3
Source (the source input to Counter 3).
Note All counter timing signals can be filtered. Refer to the PFI Filters section of
Chapter 5, Digital Input/Output and PFI, for more information.

Counter n Source Signal
The selected edge of the Counter n Source signal increments and decrements the counter value
depending on the application the counter is performing. Table 6-8 lists how this terminal is used
in various applications.
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Table 6-8. Counter Applications and Counter n Source
Application

Purpose of Source Terminal

Pulse Generation

Counter Timebase

One Counter Time Measurements

Counter Timebase

Two Counter Time Measurements

Input Terminal

Non-Buffered Edge Counting

Input Terminal

Buffered Edge Counting

Input Terminal

Two-Edge Separation

Counter Timebase

Routing a Signal to Counter n Source
Each counter has independent input selectors for the Counter n Source signal. Any of the
following signals can be routed to the Counter n Source input:
•

80 MHz Timebase

•

20 MHz Timebase

•

13.1072 MHz Timebase

•

12.8 MHz Timebase

•

10 MHz Timebase

•

100 kHz Timebase

•

Any PFI terminal

•

Analog Comparison Event

•

Change Detection Event

In addition, TC or Gate from a counter can be routed to a different counter source.
Some of these options may not be available in some driver software. Refer to the Device Routing
in MAX topic in the NI-DAQmx Help or the LabVIEW Help for more information about available
routing options.

Routing Counter n Source to an Output Terminal
You can route Counter n Source out to any PFI terminal.

Counter n Gate Signal
The Counter n Gate signal can perform many different operations depending on the application
including starting and stopping the counter, and saving the counter contents.
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Routing a Signal to Counter n Gate
Each counter has independent input selectors for the Counter n Gate signal. Any of the following
signals can be routed to the Counter n Gate input:
•

Any PFI terminal

•

AI Reference Trigger

•

AI Start Trigger

•

AO Sample Clock

•

DI Sample Clock

•

DI Reference Trigger

•

DO Sample Clock

•

Change Detection Event

•

Analog Comparison Event

In addition, a counter’s Internal Output or Source can be routed to a different counter’s gate.
Some of these options may not be available in some driver software. Refer to the Device Routing
in MAX topic in the NI-DAQmx Help or the LabVIEW Help for more information about available
routing options.

Routing Counter n Gate to an Output Terminal
You can route Counter n Gate out to any PFI terminal.

Counter n Aux Signal
The Counter n Aux signal indicates the first edge in a two-signal edge-separation measurement.

Routing a Signal to Counter n Aux
Each counter has independent input selectors for the Counter n Aux signal. Any of the following
signals can be routed to the Counter n Aux input:
•

Any PFI terminal

•

AI Reference Trigger

•

AI Start Trigger

•

Analog Comparison Event

•

Change Detection Event

In addition, a counter’s Internal Output, Gate or Source can be routed to a different counter’s
Aux. A counter’s own gate can also be routed to its Aux input.
Some of these options may not be available in some driver software. Refer to the Device Routing
in MAX topic in the NI-DAQmx Help or the LabVIEW Help for more information about available
routing options.
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Counter n A, Counter n B, and Counter n Z Signals
Counter n B can control the direction of counting in edge counting applications. Use the A, B,
and Z inputs to each counter when measuring quadrature encoders or measuring two pulse
encoders.

Routing Signals to A, B, and Z Counter Inputs
Each counter has independent input selectors for each of the A, B, and Z inputs. Any of the
following signals can be routed to each input:
•

Any PFI terminal

•

Analog Comparison Event

Routing Counter n Z Signal to an Output Terminal
You can route Counter n Z out to any PFI terminal.

Counter n Up_Down Signal
Counter n Up_Down is another name for the Counter n B signal.

Counter n HW Arm Signal
The Counter n HW Arm signal enables a counter to begin an input or output function.
To begin any counter input or output function, you must first enable, or arm, the counter. In some
applications, such as a buffered edge count, the counter begins counting when it is armed. In
other applications, such as single pulse-width measurement, the counter begins waiting for the
Gate signal when it is armed. Counter output operations can use the arm signal in addition to a
start trigger.
Software can arm a counter or configure counters to be armed on a hardware signal. Software
calls this hardware signal the Arm Start Trigger. Internally, software routes the Arm Start Trigger
to the Counter n HW Arm input of the counter.

Routing Signals to Counter n HW Arm Input
Any of the following signals can be routed to the Counter n HW Arm input:
•

Any PFI terminal

•

AI Reference Trigger

•

AI Start Trigger

•

Analog Comparison Event

•

Change Detection Event

A counter’s Internal Output can be routed to a different counter’s HW Arm.
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Some of these options may not be available in some driver software. Refer to the Device Routing
in MAX topic in the NI-DAQmx Help or the LabVIEW Help for more information about available
routing options.

Counter n Sample Clock Signal
Use the Counter n Sample Clock (CtrnSampleClock) signal to perform sample clocked
acquisitions and generations.
You can specify an internal or external source for Counter n Sample Clock. You also can specify
whether the measurement sample begins on the rising edge or falling edge of Counter n Sample
Clock.
If the cDAQ chassis receives a Counter n Sample Clock when the FIFO is full, it reports an
overflow error to the host software.

Using an Internal Source
To use Counter n Sample Clock with an internal source, specify the signal source and the
polarity of the signal. The source can be any of the following signals:
•

DI Sample Clock

•

DO Sample Clock

•

AI Sample Clock (ai/SampleClock, te0/SampleClock, te1/SampleClock)

•

AI Convert Clock

•

AO Sample Clock

•

DI Change Detection output

Several other internal signals can be routed to Counter n Sample Clock through internal routes.
Refer to Device Routing in MAX in the NI-DAQmx Help or the LabVIEW Help for more
information.

Using an External Source
You can route any of the following signals as Counter n Sample Clock:
•

Any PFI terminal

•

Analog Comparison Event

You can sample data on the rising or falling edge of Counter n Sample Clock.

Routing Counter n Sample Clock to an Output Terminal
You can route Counter n Sample Clock out to any PFI terminal. The PFI circuitry inverts the
polarity of Counter n Sample Clock before driving the PFI terminal.
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Counter n Internal Output and Counter n TC Signals
The Counter n Internal Output signal changes in response to Counter n TC.
The two software-selectable output options are pulse output on TC and toggle output on TC. The
output polarity is software-selectable for both options.
With pulse or pulse train generation tasks, the counter drives the pulse(s) on the Counter n
Internal Output signal. The Counter n Internal Output signal can be internally routed to be a
counter/timer input or an “external” source for AI, AO, DI, or DO timing signals.

Routing Counter n Internal Output to an Output Terminal
You can route Counter n Internal Output to any PFI terminal.

Frequency Output Signal
The Frequency Output (FREQ OUT) signal is the output of the frequency output generator.

Routing Frequency Output to a Terminal
You can route Frequency Output to any PFI terminal.

Default Counter/Timer Routing
Counter/timer signals are available to parallel digital I/O C Series modules. To determine the
signal routing options for modules installed in your system, refer to the Device Routes tab
in MAX.
You can use these defaults or select other sources and destinations for the counter/timer
signals in NI-DAQmx. Refer to Connecting Counter Signals in the NI-DAQmx Help or the
LabVIEW Help for more information about how to connect your signals for common counter
measurements and generations. Refer to Physical Channels in the NI-DAQmx Help or the
LabVIEW Help for a list of default PFI lines for counter functions.

Other Counter Features
The following sections list the other counter features available on the cDAQ chassis.

Cascading Counters
You can internally route the Counter n Internal Output and Counter n TC signals of each counter
to the Gate inputs of the other counter. By cascading two counters together, you can effectively
create a 64-bit counter. By cascading counters, you also can enable other applications. For
example, to improve the accuracy of frequency measurements, use reciprocal frequency
measurement, as described in the Large Range of Frequencies with Two Counters section.
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Prescaling
Prescaling allows the counter to count a signal that is faster than the maximum timebase of the
counter. The cDAQ chassis offers 8X and 2X prescaling on each counter (prescaling can be
disabled). Each prescaler consists of a small, simple counter that counts to eight (or two) and
rolls over. This counter can run faster than the larger counters, which simply count the rollovers
of this smaller counter. Thus, the prescaler acts as a frequency divider on the Source and puts
out a frequency that is one-eighth (or one-half) of what it is accepting as shown in Figure 6-37.
Figure 6-37. Prescaling
External Signal
Prescaler Rollover
(Used as Source
by Counter)
Counter Value

0

1

Prescaling is intended to be used for frequency measurement where the measurement is made on
a continuous, repetitive signal. The prescaling counter cannot be read; therefore, you cannot
determine how many edges have occurred since the previous rollover. Prescaling can be used for
event counting provided it is acceptable to have an error of up to seven (or one) ticks. Prescaling
can be used when the counter Source is an external signal. Prescaling is not available if the
counter Source is one of the internal timebases (80MHzTimebase, 20MHzTimebase, or
100kHzTimebase).

Synchronization Modes
The 32-bit counter counts up or down synchronously with the Source signal. The Gate signal and
other counter inputs are asynchronous to the Source signal, so the cDAQ chassis synchronizes
these signals before presenting them to the internal counter.
Depending on how you configure your chassis, the cDAQ chassis uses one of two
synchronization methods:
•

80 MHz Source Mode

•

External or Internal Source Less than 20 MHz
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80 MHz Source Mode
In 80 MHz source mode, the chassis synchronizes signals on the rising edge of the source, and
counts on the third rising edge of the source. Edges are pipelined so no counts are lost, as shown
in Figure 6-38.
Figure 6-38. 80 MHz Source Mode
80 MHz Source

Synchronize

Count

External or Internal Source Less than 20 MHz
With an external or internal source less than 20 MHz, the module generates a delayed Source
signal by delaying the Source signal by several nanoseconds. The chassis synchronizes signals
on the rising edge of the delayed Source signal, and counts on the following rising edge of the
source, as shown in Figure 6-39.
Figure 6-39. External or Internal Source Less than 20 MHz
Source

Synchronize
Delayed Source

Count
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7

This chapter describes digital routing, clock routing circuitry, and timebase synchronization on
the cDAQ chassis. Refer to the Digital Routing, Clock Routing, and Synchronization across a
Network sections.

Digital Routing
The digital routing circuitry has the following functions:
•

Manages the flow of data between the bus interface and the acquisition/generation
sub-systems (analog input, analog output, digital I/O, and the counters). The digital routing
circuitry uses FIFOs (if present) in each sub-system to ensure efficient data movement.

•

Routes timing and control signals. The acquisition/generation sub-systems use these
signals to manage acquisitions and generations. These signals can come from the following
sources:

•

–

Your C Series modules

–

User input through the PFI terminals using parallel digital C Series modules or the
cDAQ chassis PFI terminal

Routes and generates the main clock signals for the cDAQ chassis. To determine the signal
routing options for C Series module(s) installed in the cDAQ chassis, refer to the Device
Routes tab in MAX.
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Clock Routing
Figure 7-1 shows the clock routing circuitry of the cDAQ chassis.
Figure 7-1. Clock Routing Circuitry
Onboard
100 MHz
Oscillator

Clock
Generator

80 MHz Timebase

÷4

20 MHz Timebase

÷ 200

100 kHz Timebase

13.1072 MHz Timebase
12.8 MHz Timebase
10 MHz Timebase

80 MHz Timebase
You can use the 80 MHz Timebase as the Source input to the 32-bit general-purpose
counter/timers. The 80 MHz Timebase can be generated from the onboard oscillator.

20 MHz and 100 kHz Timebases
The 20 MHz and 100 kHz Timebases can be used to generate many of the analog input and
analog output timing signals. They can function as the Source input to the 32-bit general-purpose
counter/timers. The 20 MHz and 100 kHz Timebases are generated by dividing down the
80 MHz Timebase, as shown in Figure 7-1.

13.1072 MHz, 12.8 MHz, and 10 MHz Timebases
The 13.1072 MHz, 12.8 MHz, and 10 MHz Timebases can be used to generate many of the
analog input and analog output timing signals. They can function as the Source input to the
32-bit general-purpose counter/timers. The 13.1072 MHz, 12.8 MHz, and 10 MHz Timebases
are generated directly from the onboard clock generator.
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Synchronization across a Network
The onboard 100 MHz oscillator automatically synchronizes to other network-synchronized
chassis that are part of your local 802.1AS subnet.
The 80 MHz, 20 MHz, 100 kHz, 13.1072 MHz, 12.8 MHz, and 10 MHz Timebases are derived
from this oscillator, and are synchronized to it. Therefore, they are also synchronized to other
network-synchronized timebases on your 802.1AS subnet. This enables analog input, analog
output, digital input, digital output, and counter/timers to be synchronized to other chassis across
a distributed network.
The cDAQ-9185/9189 chassis use the IEEE 802.1AS protocol over the network to synchronize.
They can be configured to use the IEEE 1588-2008 protocol profile instead1.
Note For chassis or networks that do not support network synchronization, the
NI 9469 C Series synchronization module can be used to synchronize timebases and
clocks across chassis.

More Information about Synchronization
The following documents will help you overcome typical hurdles in getting started with
synchronized measurements:
•

How to synchronize analog input C Series modules with NI-DAQmx—This tutorial
delves into multidevice and multichassis tasks. Visit ni.com/info and enter
cdaqaisync.

•

Designing Ethernet measurement systems for synchronization, considering
topologies, masters, and third party devices—If topology changes result in a device’s
master changing, executing tasks may be affected. Visit ni.com/info and enter
cdaqenet.

•

How to achieve high accuracy measurements—Visit ni.com/info and enter
cdaqsync.

•

Choosing a CompactDAQ synchronization technology—Visit ni.com/info and enter
cdaqsynctypes.

•

Synchronization accuracy explained—Visit ni.com/info and enter syncacc.

•

Synchronizing FieldDAQ and TSN-Enabled Ethernet cDAQ Chassis to a PXI
System—Visit ni.com/info and enter fd1588.

1

IEEE 1588 protocol is supported in NI-DAQmx 18.1 and later.
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This section lists where you can find example programs for the cDAQ chassis and C Series
modules and relevant documentation.

Example Programs
NI-DAQmx software includes example programs to help you get started programming with the
cDAQ chassis and C Series modules. Modify example code and save it in an application, or use
examples to develop a new application, or add example code to an existing application.
To locate NI software examples, go to ni.com/info and enter the Info Code daqmxexp.
To run examples without the device installed, use an NI-DAQmx simulated device. For more
information, in Measurement & Automation Explorer (MAX), select Help»Help Topics»
NI-DAQmx»MAX Help for NI-DAQmx and search for simulated devices.

Related Documentation
Each application software package and driver includes information about writing applications
for taking measurements and controlling measurement devices. The following references to
documents assume you have NI-DAQmx 19.1 or later.

NI cDAQ Chassis Documentation
The cDAQ-9185/9189 Quick Start packaged with your cDAQ chassis, describes how to install
your NI-DAQmx for Windows software, how to install the cDAQ chassis and C Series module,
and how to confirm that your device is operating properly.
The cDAQ-9185 Specifications and cDAQ-9189 Specifications list all specifications for your
cDAQ chassis. Go to ni.com/manuals and search for your cDAQ chassis.
The cDAQ-9185 Safety, Environmental, and Regulatory Information and cDAQ-9189 Safety,
Environmental, and Regulatory Information include important hazardous locations information,
compliance precautions, and connection information for your cDAQ chassis. Go to ni.com/
manuals and search for your cDAQ chassis.
The cDAQ Chassis and Controllers Calibration Procedure lists the steps for verifying the
counters on cDAQ chassis and controllers. Go to ni.com/manuals and search for your cDAQ
chassis.
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C Series Module Documentation and Specifications
For general installation and module use, refer to the getting started guide included with your
C Series module. You can find the specifications for your C Series module in the datasheet on
ni.com/manuals.

NI-DAQmx
The NI-DAQmx Readme lists which devices, ADEs, and NI application software are supported
by this version of NI-DAQmx. Select Start»All Programs»National Instruments»
NI-DAQmx»NI-DAQmx Readme.
The NI-DAQmx Help contains API overviews, general information about measurement
concepts, key NI-DAQmx concepts, and common applications that are applicable to all
programming environments. Select Start»All Programs»National Instruments»Start»
All Programs»National Instruments»NI-DAQmx»NI-DAQmx Help.

LabVIEW NXG
Refer to the Taking NI-DAQmx Measurements lessons to assist in getting started in LabVIEW
NXG, beginning with NI-DAQmx API Basics. To access these lessons, enter taking
NI-DAQmx measurements in the Search bar in LabVIEW NXG

FlexLogger
Configuring Device Channels in the FlexLogger Manual presents information for adding
sensors and signals, configuring channels, and logging data in FlexLogger. Go to
ni.com/info and enter the Info Code flexloggerchannels.

LabVIEW
Refer to ni.com/gettingstarted for more information about LabVIEW.
Use the LabVIEW Help, available by selecting Help»LabVIEW Help in LabVIEW, to access
information about LabVIEW programming concepts, step-by-step instructions for using
LabVIEW, and reference information about LabVIEW VIs, functions, palettes, menus, and
tools. Refer to the following locations on the Contents tab of the LabVIEW Help for information
about NI-DAQmx:
•

VI and Function Reference»Measurement I/O VIs and Functions»DAQmx - Data
Acquisition VIs and Functions—Describes the LabVIEW NI-DAQmx VIs and functions.

•

Property and Method Reference»NI-DAQmx Properties—Contains the property
reference.

•

Taking Measurements—Contains the conceptual and how-to information you need to
acquire and analyze measurement data in LabVIEW, including common measurements,
measurement fundamentals, NI-DAQmx key concepts, and device considerations.
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LabVIEW Real-Time
The Real-Time Module Concepts book of the LabVIEW Real-Time Module Help includes
conceptual information about real-time programming techniques, application architectures, and
Real-Time Module features you can use to create real-time applications. Refer to the Real-Time
Module Concepts before attempting to create a deterministic real-time application.

LabWindows/CVI
The Data Acquisition book of the LabWindows/CVI Help contains Taking an NI-DAQmx
Measurement in LabWindows/CVI, which includes step-by-step instructions about creating a
measurement task using the DAQ Assistant. In LabWindows™/CVI™, select Help»Contents,
then select Using LabWindows/CVI»Data Acquisition. This book also contains information
about accessing detailed information through the NI-DAQmx Help.
The NI-DAQmx Library book of the LabWindows/CVI Help contains API overviews and
function reference for NI-DAQmx. Select Library Reference»NI-DAQmx Library in the
LabWindows/CVI Help.

Microsoft Visual Studio Support
You can use the NI-DAQmx .NET class library to communicate with and control an NI data
acquisition (DAQ) device. Documentation for the NI-DAQmx .NET class library is available by
selecting Start»All Programs»National Instruments»NI-DAQmx»NI-DAQmx
Documentation and then opening the NINETDAQmxFxXX.chm help file corresponding to the
version of NI-DAQmx .NET Framework language support you have installed.
•

Measurement Studio Support for NI-DAQmx—If you program your NI-DAQmxsupported device in Visual Studio using Visual C# or Visual Basic .NET, you can
interactively create channels and tasks using Measurement Studio and the DAQ Assistant.
Additionally, you can use Measurement Studio to generate the configuration code based on
your task or channel. Refer to the DAQ Assistant Help for additional information about
generating code.

To create an NI-DAQmx application using Visual Basic .NET or Visual C#, follow these general
steps:
1.

In Visual Studio, select File»New»Project to launch the New Project dialog box.

2.

Choose a programming language (Visual C# or Visual Basic .NET), and then select
Measurement Studio to see a list of project templates.

3.

Select NI DAQ Windows Application. Choose a project type. You add DAQ tasks as a
part of this step.

•

.NET Languages without NI Application Software—With the Microsoft .NET
Framework, you can use the NI-DAQmx .NET class library to create applications using
Visual C# and Visual Basic .NET without Measurement Studio. Refer to the NI-DAQmx
Readme for specific versions supported.
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ANSI C without NI Application Software
The NI-DAQmx Help contains API overviews and general information about measurement
concepts. Select Start»All Programs»National Instruments»NI-DAQmx»NI-DAQmx Help.
The NI-DAQmx C Reference Help describes the NI-DAQmx Library functions, which you can
use with National Instruments data acquisition devices to develop instrumentation, acquisition,
and control applications. Select Start»All Programs»National Instruments»NI-DAQmx»
Text-Based Code Support»NI-DAQmx C Reference Help.

Training Courses
If you need more help getting started developing an application with NI products, NI offers
training courses. To enroll in a course or obtain a detailed course outline, refer to ni.com/
training.

Technical Support on the Web
For additional support, refer to ni.com/support or ni.com/examples.
Note

You can download these documents at ni.com/manuals.

Many DAQ specifications and user guides/manuals are available as PDFs. You must have Adobe
Reader 7.0 or later (PDF 1.6 or later) installed to view the PDFs. Refer to the Adobe Systems
Incorporated website at www.adobe.com to download Adobe Reader. Refer to the National
Instruments Product Manuals Library at ni.com/manuals for updated documentation
resources.
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NI provides global services and support as part of our commitment to your success. Take
advantage of product services in addition to training and certification programs that meet your
needs during each phase of the application life cycle; from planning and development through
deployment and ongoing maintenance.
To get started, register your product at ni.com/myproducts.
As a registered NI product user, you are entitled to the following benefits:
•

Access to applicable product services.

•

Easier product management with an online account.

•

Receive critical part notifications, software updates, and service expirations.

Log in to your MyNI user profile to get personalized access to your services.

Services and Resources
•

•

Maintenance and Hardware Services—NI helps you identify your systems’ accuracy and
reliability requirements and provides warranty, sparing, and calibration services to help you
maintain accuracy and minimize downtime over the life of your system. Visit ni.com/
services for more information.
–

Warranty and Repair—All NI hardware features a one-year standard warranty that
is extendable up to five years. NI offers repair services performed in a timely manner
by highly trained factory technicians using only original parts at an NI service center.

–

Calibration—Through regular calibration, you can quantify and improve the
measurement performance of an instrument. NI provides state-of-the-art calibration
services. If your product supports calibration, you can obtain the calibration certificate
for your product at ni.com/calibration.

System Integration—If you have time constraints, limited in-house technical resources, or
other project challenges, National Instruments Alliance Partner members can help. To learn
more, call your local NI office or visit ni.com/alliance.
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•

•

•

NI Services

Training and Certification—The NI training and certification program is the most
effective way to increase application development proficiency and productivity. Visit
ni.com/training for more information.
–

The Skills Guide assists you in identifying the proficiency requirements of your
current application and gives you options for obtaining those skills consistent with
your time and budget constraints and personal learning preferences. Visit ni.com/
skills-guide to see these custom paths.

–

NI offers courses in several languages and formats including instructor-led classes at
facilities worldwide, courses on-site at your facility, and online courses to serve your
individual needs.

Technical Support—Support at ni.com/support includes the following resources:
–

Self-Help Technical Resources—Visit ni.com/support for software drivers and
updates, a searchable KnowledgeBase, product manuals, step-by-step troubleshooting
wizards, thousands of example programs, tutorials, application notes, instrument
drivers, and so on. Registered users also receive access to the NI Discussion Forums
at ni.com/forums. NI Applications Engineers make sure every question submitted
online receives an answer.

–

Software Support Service Membership—The Standard Service Program (SSP) is a
renewable one-year subscription included with almost every NI software product,
including NI Developer Suite. This program entitles members to direct access to
NI Applications Engineers through phone and email for one-to-one technical support,
as well as exclusive access to online training modules at ni.com/
self-paced-training. NI also offers flexible extended contract options that
guarantee your SSP benefits are available without interruption for as long as you need
them. Visit ni.com/ssp for more information.

Declaration of Conformity (DoC)—A DoC is our claim of compliance with the Council
of the European Communities using the manufacturer’s declaration of conformity. This
system affords the user protection for electromagnetic compatibility (EMC) and product
safety. You can obtain the DoC for your product by visiting ni.com/certification.

For information about other technical support options in your area, visit ni.com/services,
or contact your local office at ni.com/contact.
You also can visit the Worldwide Offices section of ni.com/niglobal to access the branch
office websites, which provide up-to-date contact information, support phone numbers, email
addresses, and current events.
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two-signal edge-separation
measurement, 6-23

Numerics
10/100/1000 LED, 1-30
80 MHz source mode, 6-40

A
acquisitions, digital waveform, 5-2
ACTIVE LED, 1-29
analog input
getting started with applications in
software, 3-8
timing signals, 3-1
triggering, 3-1
analog input signals
AI Convert Clock behavior, 3-3
AI Pause Trigger, 3-7
AI Reference Trigger, 3-6
AI Sample Clock, 3-2
AI Sample Clock Timebase, 3-2
AI Start Trigger, 3-5
analog output
data generation methods, 4-1
getting started with applications in
software, 4-8
glitches on the output signal, 4-7
timing signals, 4-3
triggering, 4-3
watchdog timer, 4-8
analog output signals
AO Pause Trigger, 4-6
AO Sample Clock, 4-4
AO Sample Clock Timebase, 4-4
AO Start Trigger, 4-5
ANSI C documentation, A-4
applications
counter input, 6-3
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edge counting, 6-4
arm start trigger, 6-3

C
C Series module
specifications, A-2
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cDAQ chassis
diagram, 1-2
features, 1-29
installation and configuration, 1-6
mounting, 1-18
reserving in MAX, 1-17
troubleshooting device connectivity,
1-29
unpacking, 1-3
using, 1-36
cDAQ module interface, 1-37
channel Z behavior, 6-20
chassis grounding screw, 1-29
choosing frequency measurement, 6-15
configuration, 1-6
connector
power, 1-32
continuous pulse train generation, 6-27
controlling counting direction, 6-4
counter signals
Counter n A, 6-36
Counter n Aux, 6-35
Counter n B, 6-36
Counter n Gate, 6-34
Counter n HW Arm, 6-36
Counter n Internal Output, 6-38
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© National Instruments

|

I-1

Index

Counter n Up_Down, 6-36
FREQ OUT, 6-38
Frequency Output, 6-38
counters, 6-1
cascading, 6-38
edge counting, 6-4
generation, 6-24
input applications, 6-3
other features, 6-38
output applications, 6-24
prescaling, 6-39
pulse train generation, 6-26
retriggerable single pulse generation,
6-26
simple pulse generation, 6-24
single pulse generation, 6-25
with start trigger, 6-25
synchronization modes, 6-39
timing signals, 6-33
triggering, 6-3
watchdog timer, 6-32
counting edges, 6-4

D
data
AO generation methods, 4-1
DO generation methods, 5-9
DI Sample Clock signal, 5-3
digital I/O
change detection event, 5-8
configuration for NI 9401, 5-14
digital input, 5-2
digital output, 5-8
parallel versus serial DIO modules, 5-1
static DIO, 5-2
waveform acquisition, 5-2
digital input
filters (parallel DIO modules only), 5-7
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DI Reference Trigger, 5-5
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DI Sample Clock, 5-3
DI Sample Clock Timebase, 5-3
DI Start Trigger, 5-4
digital output
data generation methods, 5-9
getting started with applications in
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timing signals, 5-10
triggering, 5-10
watchdog timer, 1-34, 4-8, 5-14, 6-32
digital output signals
DO Pause Trigger, 5-12
DO Sample Clock, 5-11
DO Sample Clock Timebase, 5-11
DO Start Trigger, 5-11

E
edge counting, 6-4
buffered, 6-5
on-demand, 6-4
sample clock, 6-5
single point, 6-4
edge-separation measurement
buffered two-signal, 6-23
single two-signal, 6-23
electromagnetic compatibility guidelines, 1-2
encoders, quadrature, 6-20
encoding
X1, 6-20
X2, 6-20
X4, 6-20
equivalent time sampling, 6-32
Ethernet
cabling, 1-30
LEDs, 1-30
port, 1-29
external source less than 40 MHz, 6-40
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filters
digital input (parallel DIO modules
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FREQ OUT signal, 6-38
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frequency
division, 6-32
generation, 6-31
generator, 6-31
measurement, 6-11
Frequency Output signal, 6-38

G
generations
analog output data, 4-1
buffered hardware-timed
analog output, 4-2
digital output, 5-9
continuous pulse train, 6-27
digital output data, 5-9
frequency, 6-31
hardware-timed
analog output, 4-2
digital output, 5-9
pulse for ETS, 6-32
pulse train, 6-26
retriggerable single pulse, 6-26
simple pulse, 6-24
single pulse, 6-25
single pulse with start trigger, 6-25
software-timed
analog output, 4-1
digital output, 5-9
getting started
AI applications in software, 3-8
AO applications in software, 4-8
DI applications in software, 5-7
DO applications in software, 5-14

installation, 1-6
internal source less than 40 MHz, 6-40

L
LabVIEW documentation, A-2
LabWindows/CVI documentation, A-3
LEDs, 1-29
Ethernet, 1-30
POWER, STATUS, ACTIVE, 1-29
LINK/ACT LED, 1-30

M

hardware-timed generations
analog output, 4-2
digital output, 5-9

MAX chassis reservation, 1-17
Measurement Studio documentation, A-3
measurements
buffered two-signal edge-separation,
6-23
choosing frequency, 6-15
frequency, 6-11
implicit buffered pulse-width, 6-7
implicit buffered semi-period, 6-10
period, 6-19
position, 6-19
pulse-width, 6-6
semi-period, 6-10
single pulse-width, 6-6
single semi-period, 6-10
single two-signal edge-separation, 6-23
two-signal edge-separation, 6-22
using quadrature encoders, 6-20
using two pulse encoders, 6-21
measuring
high frequency with two counters, 6-12
large range of frequencies using two
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low frequency, 6-11
minimizing glitches on the output signal, 4-7
mounting, 1-18
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pause trigger, 6-3
period measurement, 6-19
PFI 0 SMB connector, 1-32
PFI filters, 5-14
ports
PFI 0 SMB, 1-32
position measurement, 6-19
buffered, 6-21
power connector, 1-32
POWER LED, 1-29
prescaling, 6-39
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encoders, 6-21
generation for ETS, 6-32
train generation, 6-26
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pulse-width measurement, 6-6
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single, 6-6

Q
quadrature encoders, 6-20

R

pulse generation, 6-25
retriggerable, 6-26
with start trigger, 6-25
pulse-width measurement, 6-6
semi-period measurement, 6-10
two-signal edge-separation
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software-timed generations
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STC3, 1-37
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external source less than 40 MHz, 6-40
internal source less than 40 MHz, 6-40
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arm start, 6-3
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start, 6-3
troubleshooting, device connectivity, 1-17
two-signal edge-separation measurement,
6-22
buffered, 6-23
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reciprocal frequency measurement, 6-13
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reset button, 1-31
retriggerable single pulse generation, 6-26
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watchdog timer, 1-34, 4-8, 5-14, 6-32

X
X1 encoding, 6-20
X2 encoding, 6-20
X4 encoding, 6-20

